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Lexmark Document Distributor overview

Lexmark™ Document Distributor (LDD) is a system for capturing paper documents and converting them to
digital format. It is also a system for capturing existing digital documents, and then processing and routing these
documents according to your business processes. Users can submit paper documents from multifunction
printers (MFPs), or they can submit digital documents from individual computers. Additionally, some functions,
such as print release, may be accessed from some single-function printers.

Each Lexmark MFP can print, copy, scan, e-mail, FTP, and fax. In addition to controlling and adjusting settings
for these native functions, LDD can add the following functions by using scripts:

® Show messages and prompt the user for input.

® Authenticate through prompts or card swipes.

® Combine scanned documents.

® Read bar codes.

® Use optical character recognition (OCR) to retrieve the text from scanned documents.

® Check or validate information in documents against templates.

* Automatically fill fields on a form template from a database or user input.

® Convert documents to specific formats, such as PDF documents, TIFF images, and plain text.

® Route and store documents in a database, network location, or enterprise content management (ECM)
system.

® Provide a user confirmation of actions taken.

Understanding the stages of a job

Document capture

The paper document is converted into a digital document from a Lexmark printer, or a digital document is
selected on a user's computer. The user chooses from profiles, predefined job types that determine through
scripts how the scanned document will be processed and routed. On a printer, the most commonly used profiles
are often configured as buttons on the home screen.

Document processing

Document processing takes place on the LDD server after the document capture stage is complete. The
document is analyzed or modified according to scripts associated with the profile selected prior to document
capture.

Common tasks in document processing include reading bar codes, OCR, and image processing and
manipulation.
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Document routing

The main function of LDD is delivering captured documents to other systems. The application uses its
processing capabilities to transform paper documents into formats required by your business processes. A
document can be routed to multiple destinations. When a user submits a document, LDD can automatically fax,
e-mail, print, or archive it without further user intervention.
LDD can route documents to any of the following destinations:

®* ECM systems, such as Perceptive Content, SharePoint, and Documentum

® E-mail recipients

® Fax recipients

* Network folders

® FTP locations

® Printers

Confirmation

After document capture, processing, and routing, the user can be provided with feedback indicating success
or failure. A custom report may be printed, or a confirmation prompt can be displayed on the screen of e-Task 2
or later printers. Additionally, other LDD services can be used for confirmation purposes. For example, an
e-mail notification can be sent to the user or other recipients each time a job is completed.

Understanding the Lexmark Document Distributor system

System components

® Clients—Clients can be either printers or workstations that use Select'N'Send (SnS) or the Lexmark
Document Server Port. The document capture and confirmation stages of a job occur at a client, and, in the
case of printer clients, prompts may be presented to the user to collect information during document
processing and document routing.

* Load balancer—The load balancer receives jobs from clients and balances those jobs across servers,
providing a transition between document capture and document processing stages of a job.

* LDD servers—The servers process incoming jobs, managing document processing and document routing
stages of a job.

* Database—The database maintains information about clients, solutions, settings, and jobs.
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Adminstration
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Reliability, scalability, and disaster recovery

The load balancer, database, and server components may be installed together on one computer or separately
on individual computers, depending on the demands placed on the system. However, a one-computer setup
is subject to downtime if that computer fails, and the server load will be fairly limited. Ideally, a system should
have at least two server computers, connected to separate database and load balancer computers.

LDD is scalable to support a large number of clients, submitting jobs to as many servers as required to handle
the load. The load balancer selects a server for each received job to distribute the total load and maintain
system performance. Using multiple servers also increases system reliability. If one server fails, then the load
balancer will direct jobs to the other servers until the failed server is back online.

LDD uses a Tomcat Connector to manage load balancing in the system. The default balancing method is
session, which estimates the number of sessions open by counting requests to the system that do not have a
session cookie. The session count is decayed by dividing in half, once per minute by default. The server with
the lowest number of estimated sessions is selected to process the request.

To further increase reliability by keeping the system online in the event of a failing load balancer or database,
the load balancer and database can each be paired in a failover cluster using a Microsoft Cluster Server (MSCS).
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Finally, you can back up the databases and solutions from the database and load balancer to a network share.
If a recovery becomes necessary, then a new load balancer and/or database can access the recovery data
using a Restore Install. Existing servers are directed to the new database and/or load balancer, or new servers
are installed as necessary.

Workflow solutions

A workflow solution determines the specifics of each stage of ajob in LDD to meet a business need. A workflow
solution provides a new profile, or job type that a user can initiate on a printer or software client to which it is
deployed. Some solutions, however, may be scheduled to run at particular times.

Held jobs —> Profiles
= Invoice (Type 1)
<&
& Invoice (Type 2)
Invoice (Type 3)

Search
Profiles

Job Applications

Resumes

Tax Records

f I Displaying 1-6 / 7 /'5‘ /] y ’

CRRRRR

A workflow solution contains some or all of the following elements:

Script—Defines the actions executed when a solution is initiated. Scripts can be static, or they may solicit
user input for processing and routing documents. For example, a script that processes bank loans may
request more user inputs, such as a branch name, account number, or social security number.

Policy—The settings for the solution and the printers to which it is deployed:

— Device settings—The configuration required on printers to support the jobs. This configuration typically
includes profiles but can include almost any device setting.

— Solution settings—Settings that allow you to adjust jobs or printer configurations. Some settings are
global to the solution across all printers, while others vary from one group of printers to another.

Embedded Solution Framework (eSF) application—An application installed on printers to provide
functionality needed by the solution, such as delayed sending of scanned documents.

Components—JAR files that provide services not available in the base LDD installation, such as interaction
with a custom ECM system.

Formsets—Custom form files used for merging data with standard forms.
Custom reports—Reports created by a solution developer that present custom data.

Solution Status Page—A Web page that can be included with solutions to view system status and perform
basic operations related to a solution.
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Client software

Client software is used to submit files from a Windows computer to the LDD system for processing. A computer
that uses client software is known as a software client. LDD can process documents submitted through client
software in the same way as documents scanned at a printer.

Note: For more information on the latest LDD port monitor support, see the Readme file.

There are two types of client software:

® Select'N'Send—This is a Windows application, including both a command line utility and a GUI version, that
lets users send files directly to LDD and select LDD profiles to use in processing the sent files. Selected files
are submitted to the system in their current formats.

Note: Select'N'Send does not support prompting from an LDD server system profile.

® Lexmark Document Server Printer Port—This is a port monitor that lets users submit documents to LDD
by printing from any Windows application to a print queue assigned to the port. Printed documents are
submitted to the system in the format determined by the print driver used with the print queue.

An LDD printer port can now be assigned to an LDD server system profile that prompts for user input at the
time of printing. The prompting is controlled by the profile or script running on the LDD server system that
the LDD printer port is assigned to. For LDD printer port prompting, the LDD port monitor software must be
installed on the computer. The LDD printer port must be created and assigned to a profile that prompts to
an existing print queue.

Notes:

— LDD printer port prompting is not supported on print servers. Do not configure an LDD port on a print
server to use a profile that prompts; otherwise, the spooler will stop responding and possibly crash
when print jobs start going into the print server. You can still use LDD ports on print servers, but you
can only assign them to profiles that do not prompt

— Configure the nonprompting profiles in the SDK with a property in the SDK that specifies that the
profile does not prompt. This helps improve the performance of an LDD port assigned to a
nonprompting profile. For more information on the nonprompting setting for software profiles, see
the Lexmark Document Distributor SDK Guide
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Lexmark Management Console

Lexmark Management Console (LMC) provides system administration for Lexmark Document Distributor. LMC
is @ Web application hosted on the LDD servers and accessed through the computer where the load balancer
is installed. LMC is accessible from anywhere on the network using a Flash plug-in with a supported browser.
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Security overview

* Administrative security—Lexmark Management Console is password-protected so that only authorized
administrators can access it.

® User authentication—Printers may require users to log in to run profiles. Text and password prompts are
available for use in scripts. Kerberos authentication is available for use only with printers that support it.

Note: Enable secure communication between printers and servers in the LMC for any device group that
uses a solution with Kerberos authentication.

* Data encryption—Data encryption is available for communication between any two LDD components or
with any Lexmark printer that supports encryption. Encryption for communication between LDD components
is accomplished using Internet Protocol Security (IPsec) through your operating system. Encryption for
communication with printers can be enabled for each device group in LMC.

System setup overview

Each of the following steps represents a different stage of the system setup process, covered in the chapter
indicated:

1 Activate the appropriate licenses, and then install the database, load balancer, and servers. For more
information, see “Installing Lexmark Document Distributor” on page 16.

2 Performinitial system configuration, including setting up device groups, discovering printers, and scheduling
a backup. For more information, see “Managing device groups and devices” on page 85 and “Backup and
disaster recovery” on page 75.

3 Deploy solutions to printers. For more information, see “Managing solutions and cSF apps” on page 80.
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4 Ifyou are using software clients, prepare software client groups and install client software where necessary.
For more information, see “Managing software clients” on page 99.

5 Test deployed solutions on printers and software clients. For more information, see “Testing and using
Lexmark Document Distributor solutions” on page 107.

Supported printers

e-Task 4 printers e-Task 3 e-Task 2+ e-Task 2 e-Task printers’ X642
printers printers printers printers
e-Task 4 (7- or 10-inch | & X548 ® X463,X464, | ® X644,X646 | ® X6202 X642
screen MFPs) 6500 X466 o X772 * X632, X6342
* MX610, Mx611 X746,X748 | ® X651 X652, | o x782 * X7522
* MX6500,MX6500e | o y795 X654, X856, |, yg50, x852, | * x820?
X658 ’ ’
e MX810, MX811, X954 X738 | ® X940,X945 | o x9122
MX812
C748 X860. X862, | * 16543 e C520, C522,
MX912 C925 3 C530, C532
[ )
e CX510 1656 3
* C950 Ch34
e-Task 4 (4.3-inch e (C732,C734,
screen MFPs) C7363
* MX410, MX510, e C780, C7823
MX511 e C9203
® CX410 e C9353
SFP e-Task 4 (4.3-inch e E4503
screen) * E460, E462°
* MS610 * T640, T632,
* CS510 T6443
* MS810 ® T650, 76523
* MSOMN * W8403
SFP e-Task 4 (7-inch
screen)
* MS812
"These printers do not support eSF applications used in hybrid solutions.
2 These printers may be identified as “C,” “T,” or “W” models in Lexmark Management Console.
3 These single-function printers do not support all prompts supported by multifunction printers. For a list of supported
prompts, see “Prompts supported by single-function printers” on page 126.

J

Notes:

® For more information on the latest device and firmware level support, see the Readme file.

® Some printer models do not support double-byte characters. For more information, see “Double-byte
character support” on page 126.
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Supported ECM platforms

® Perceptive Content or ImageNow 6.6, 7.x, or later

Windows SharePoint

Microsoft SharePoint Foundation 2010

Microsoft SharePoint 2010

Microsoft Office SharePoint Server 2007

— Windows SharePoint Services 3.0

EMC Documentum 5.3

IBM FileNet P8 with one of the following components:

— Content Services connector
— Image Services connector
— Content Engine
— Content Engine with shared repository
* Autonomy iManage WorkSite with WorkSite Server 8.2 or 8.5

Notes:

* |ntegration with ECM systems may require specific licenses.

® For ECM platforms without direct integration, the application saves documents and metadata to a
directory where an ECM system is configured to poll for files.
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Installing Lexmark Document Distributor

System requirements

Category

Operating system

Required

* Windows Server 2012 R2
Standard or Enterprise Edition
(x64)

® Windows Server 2012 Standard or
Enterprise Edition (x64)

® Windows Server 2008 R2
Standard or Enterprise Edition
(x64)

* Windows Server 2008 Standard
or Enterprise Edition with SP2
(x86 and x64)

® Windows Server 2003 R2
Standard or Enterprise Edition
with SP2 (x86 and x64)

* Windows Server 2003 Standard
Edition with SP2 (x86 and x64)

Recommended for enterprise
systems

Windows Server 2008 R2 (x64)
Windows Server 2012 R2 (x64)

Processor 2GHz dual-core Dual 2.5GHz quad-core Intel Xeon or
AMD Opteron
RAM 2GB 4GB

Note: Install the database on the fastest available hardware with the fastest disk I/O infrastructure.
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Category

Hard disk drive

Required

20GB free space for each system
component

Recommended for enterprise
systems

Configuration 1-N, X-N, or X-Y-N:
® Database and load balancer

— Operating system and server
configured for LMC installed
on two 15000 RPM
Serial-Attached SCSI drives
configured as a RAID 1 array
with at least 80GB free space

— Database and load balancer
installed on four 15000 RPM
Serial-Attached SCSI drives
configured as a RAID 5 array,
with at least 300GB free space

® Servers

— Operating system and server
configured for jobs installed
on four 15000 RPM
Serial-Attached SCSI drives
configured as a RAID 5 array
with at least 80GB free space

Note: For more information, see
“Assigning servers to only run LMC
or process jobs” on page 59.

Network speed

100Mbps network

Note: For solutions that require
intensive processing and more
network traffic, use a Gigabit
Ethernet.

Gigabit Ethernet using dual-port
network adapters

Network name resolution

Domain Name System (DNS) or
Windows Internet Name Service
(WINS)

Notes:

® |ocal hosts files can be used
instead of external DNS.

® For other network systems
support, contact the Lexmark
Professional Services.

Note: Install the database on the fastest available hardware with the fastest disk I/O infrastructure.
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Category Required Recommended for enterprise
systems
Static addressing ® |n databases installed on a cluster | In all system components and any

® |n load balancers installed on a printers used with the system

cluster

® |nload balancers in a system with
printers

® |nload balancers in a system with
printers not configured to a DNS
server

Note: Install the database on the fastest available hardware with the fastest disk I/O infrastructure.

Category Requirements

Browser ® Internet Explorer 7.0 or later

® Mozilla Firefox 9.0 or later

® Google Chrome
® Adobe Flash Player 10 or later
Note: Enable cookies in the browser where the LMC address is accessed.

Video Capable of displaying 1024 x 768 or higher resolutions

Requirement

Virtual machine monitor VMware ESX 3.0.1 or later
VMware vSphere 4.x or later

Note: We do not recommend installing the database on a virtual machine.

Client software operating system compatibility

Select'N'Send and the Lexmark Document Server Printer Port can be used on the following operating systems:
* Windows Server 2012 R2 Standard or Enterprise Edition (x64)
® Windows Server 2012 Standard or Enterprise Edition (x64)
® Windows Server 2008 R2 Standard or Enterprise Edition (x64)
® Windows Server 2008 Standard or Enterprise Edition with SP2 (x86 and x64)
® Windows Server 2003 R2 Standard or Enterprise Edition with SP2 (x86 and x64)
® Windows Server 2003 Standard or Enterprise Edition with SP2 (x86 and x64)
* Windows 8.1 (x86 and x64)
* Windows 8 (x86 and x64)
® Windows 7 with SP1(x86 and x64)
® Windows Vista with SP2 (x86 and x64)

Note: Enterprise Editions and Enterprise x64 Editions of Windows Server support an active/passive or
active/active clustered print server with the Lexmark Document Server Printer Port.

Supported database servers
® Firebird (default)
® Microsoft SQL Server 2014 Standard or Enterprise Edition (x86 and x64)
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® Microsoft SQL Server 2012 Standard or Enterprise Edition (x86 and x64)
® Microsoft SQL Server 2008 R2 Standard or Enterprise Edition (x86 and x64)

Note: Microsoft SQL Server Express is not supported by LDD.

Preparing for the installation

1 Download the installation package and the license files.

Note: Save the installation package and license files in the same location.

2 If necessary, unblock the file properties of the installer:
From the properties of the installation package, click Unblock, and then apply the changes.

3 Extract the installation package, and then follow the instructions for installation.

Avoiding conflicts with other software

® |nstall each system component on a computer with a new Windows installation and with no other

software installed.
® Avoid installing other software that includes these applications on the same computer where LDD

components are installed:
— Apache HTTP Server
— Apache Tomcat

— Firebird database server
® Microsoft Internet Information Services (IIS) may conflict with Apache HTTP Server and should not be

installed.

Ports used by the LDD system

Communication using the following ports should be allowed on the network.

Notes:
® Ports depend on the implementation of each LDD system and may differ from the listing shown here.
® The LDD administrator determines the ports used by forms printers.
® SSL communication is no longer supported in LDD 4.8.5.

Component Port Protoco Function

Database (Firebird) 3050 |TCP Database communications

8001 TCP Backup/restore agent




Installing Lexmark Document Distributor 20

Component Port Protoco Function
|

Load balancer 443 TCP Load balancer HTTPS TLS communications, including LMC
4113 TCP Web adapter (JMX)

9700 |TCP Profile submission to e-Task printers, Web adapter (JMX)
9705 |TCP Apache agent

9780 |TCP Load balancer communications, including LMC
9783 TCP Load balancer HTTPS TLS communications, including LMC

Server 4111 TCP JMX
511 TCP RMI

8009 |[TCP AJP/Tomcat connector (load balancer worker)

9743 TCP HTTPS TLS profile job submission from printers or client software to a
server, including LMC

9788 |TCP Profile job submission from printers or client software to a server,
including LMC
Printer 79 TCP Finger
161 UDP SNMP, device discovery
5000 |TCP Policy updates, ObjectStore plain text communication

5353 |UDP Multicast DNS

6000 |UDP Device discovery, ObjectStore communication using XML protocol

6100 UDP Device discovery, policy updates, Lexmark Secure Transport (LST)
encrypted data

6110 TCP Device discovery, policy updates, LST authentication, and negotiation

9100 TCP Printing, policy updates

9300 UDP Device discovery, NPA protocol UDP communications
9500 |[TCP NPA protocol TCP communications

Obtaining licenses

* [fyour Lexmark representative provides the license files, then save them in a folder accessible to the server,
and then continue with the server installation.

® For more information on licensing, contact your Lexmark representative.



Installing Lexmark Document Distributor 21

Understanding installation types

Two types of LDD systems can be installed:
* Workgroup system—This is an LDD installation with a packaged solution for smaller systems. Installing a
workgroup system quickly installs the database, load balancer, and one server on one computer, and a
solution is installed during the installation.

® Enterprise system—This is the standard LDD installation for larger systems and more demanding
applications. Installing an enterprise system lets you install the database, load balancer, and servers on
different computers to create a reliable and scalable system.

Installing a workgroup system

Configuration type for workgroup systems

Description Advantage Disadvantage
Database (DB), load balancer (LB), and server on a single computer | Minimum No failover for database or
equipment load balancer, limited
DB resources
LB
Server

Installation overview for a workgroup system

1 Configure the computer where to install LDD on the network.

2 Activate and download licenses.

3 Install LDD using a workgroup installation.

4 Change the administrator password, and optionally, the administrator user name.
5 Temporarily set servers online to test function.

Note: Because software clients are managed differently than printers, client software is installed later in the
system setup process. For information about installing client software and managing software clients, see
“Managing software clients” on page 99.
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Installing system components in a workgroup system

1 From the LDD installation package, run Setup.exe.

From the Lexmark Solutions installation window, click Install Workgroup System.
Click Agree to accept the license agreement.

Specify the folder where the server software should be installed, and then click Next.

ga A W N

If multiple network adapters are present, then select the network containing your printers by selecting the
IP address of the server on that network, and then click Next.

6 |If you are installing a system to recover a backup, then do the following:
a Select Restore Install (RI).

b Type the path of the folder containing the .ri file from the backup, or click the folder icon and then locate
the .rifile.

7 Specify the folder where you stored the license files during the activation process.
Notes:

¢ [fthe license files are located on a network share that requires authentication, then you must supply
authentication before specifying the license location. To authenticate with the remote server, click
Start > Run, type the UNC path to the share (for example, \\myserver\myshare\), and then type
the user name and password when prompted.

® During installation, the license files are copied to the program folder. You can safely move the license
files from the temporary location where you saved them.

8 Specify the solution file that should be installed with the workgroup system.
9 Click Finish > Done.

Installing an enterprise system

Configuration types for enterprise systems

When installing an enterprise system, Lexmark Document Distributor can be installed using the following
hardware configurations:
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Configuration Description Advantages Disadvantages
1-N Database (DB) and load balancer (LB) on one computer, server | Improved Increased
on one or more additional computers (most common setup performance |hardware needs,
when failover is not used) no failover for
database or load
balancer
DB Server(s)
1-1-N Database (DB) and load balancer (LB) on separate computers, | Further Further increased
server on one or more additional computers improved hardware needs,
performance | no failover for

Note: An external Microsoft SQL database may be installed
in place of the standard database, resulting in an E-1-N
configuration. The external database (E) and load balancer
(LB) are on separate computers, and the server is on one or

more additional computers.

database or load
balancer
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Configuration Description Advantages Disadvantages
X-N Database (DB) and load balancer (LB) together on X computers | High Increased
in a Microsoft Cluster Server for failover, server on one or more | availability, hardware needs,
additional computers (most common setup when using improved cluster licensing
failover) performance
DB
LB Server(s)
(cluster)
X-Y-N Database (DB) on X computers in a Microsoft Cluster Server |High Further increased
for failover, load balancer (LB) on Y other computers in a availability, hardware needs,
Microsoft Cluster Server for failover, server on one or more | further cluster licensing
additional computers improved
performance
LB
(cluster) Server(s)

(cluster)

|

==

Note: An external Microsoft SQL database may be installed
in place of the standard database, resulting in an E-Y-N
configuration. The external database (E) on X computers and
the load balancer (LB) on Y other computers are in a
Microsoft Cluster Server for failover. The server is on one or
more additional computers.
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Using multiple systems for high availability

When configuring multiple Lexmark Document Distributor systems, you can connect them to a hardware load
balancer or Global Site Selector (GSS) to provide high availability, without using clustering, as well as increased
capacity.

Hardware load balancer

A
Clum =

Load
balancers/
databases

Servers

T1 T2 T3 T4 T5 T6
Configuration 1-N Configuration 1-N Configuration 1-N
LDD system LDD system LDD system

Each system group contains two identical Lexmark Document Distributor systems. Jobs are balanced between
these systems in each group by the hardware load balancer or GSS. If a failure occurs in one system in a group,
then the other system in the group receives all incoming jobs until the failed system can be restored.

With this type of setup, you need additional computers, as well as a hardware load balancer or GSS. You also
need to manually configure these systems to be identical.

Note: Printers that do not support eSF applications cannot be used with a Lexmark Document Distributor
system that uses a hardware load balancer or GSS.

When a hardware load balancer is used with multiple Lexmark Document Distributor systems, the hardware
load balancer must be configured as follows:
® The X-Forwarded-For HTTP header must be inserted into incoming packets.

The packets going into the Lexmark Document Distributor systems from the HW LB should not appear to
be from the hardware load balancer of the packet headers so that device or clients groups and their settings
will work properly.

® Cookie-based session persistence must be disabled.

This is needed in case one of the Lexmark Document Distributor systems is down. If this is enabled, then
LMC may not work properly when one of the Lexmark Document Distributor systems is down.

® The load balancing algorithm should be set to Round Robin.

Based on tests made on hardware balancing algorithms, Lexmark Document Distributor systems work better
with round robin than the other algorithms.
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System sizing guidelines

There are two main factors for determining the number of servers required to process jobs efficiently:

* Peak demand—This is usually the deciding factor when the average execution time for a solution is under
30 seconds.

® Concurrency—This is usually the deciding factor when the average execution time for a solution is over 30
seconds.

Additionally, the database, when installed on the recommended hardware and connected using Gigabit
Ethernet, can process 200,000 logged messages per hour, which is approximately 40,000 jobs per hour when
using a typical solution (five logged messages per job). If this limit is reached, then it may be necessary to use
multiple systems.

Peak demand

Use the following formulas to determine the number of servers necessary to handle peak loads for a particular
solution:

(System-wide hourly job rate) = (system printer capacity) x (jobs per printer per day) / (length of business day)
(Peak demand) = 2 x (system-wide hourly job rate)
(Minimum number of servers) = (peak demand) / (single-server throughput for current solution)

Consider the following example:
® Each server in your system can process 3000 jobs per hour using the solution.
® There is capacity for 300 printers in your system.
® Each printer in your system averages 100 jobs per day.

Perform the following calculations:

1 Determine the system-wide hourly job rate:
(300 printers) x (100 daily jobs/printer) / (8 hours/day) = 3750 jobs/hour

2 Determine the peak demand:
2 x (3750 jobs/hour) = 7500 jobs/hour

3 Determine the minimum number of servers:
(7500 jobs/hour) / (3000 jobs/hour) = 2.5

Rounding up, the system should include three servers to reliably handle the peak load for a solution with
average execution time below 30 seconds.

The single-server throughput for a solution must be determined by the solution developer, though the following
typical throughputs on a server with the recommended hardware may help determine a rough estimate:

Solution processing Functions used Average single-server

load throughput

Typical ® Some image processing 6000-8000 jobs per hour
® Printing

Heavy ® Extensive image processing 2000-3000 jobs per hour
® Bar codes

® External processes

® Small to medium Document Producer (e-forms) jobs
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Solution processing Functions used Average single-server

load throughput

Very heavy (OCR) * OCR 100-200 jobs per hour
® [arge Document Producer (e-forms) jobs

Note: Using less than the recommended RAM significantly reduces throughput. For example, a

dual-processor server with only 2GB of RAM can process only 600-800 jobs/hour when using a “heavy”
solution.

For more information, see the Lexmark Document Distributor SDK Guide.

Concurrency

Each server that meets recommended requirements can process 30 concurrent jobs from clients. The following
formula determines the number of servers necessary to meet concurrency requirements:

(minimum number of servers) = (humber of printers expected to submit jobs near the same time) / 30
For example, assume that 1/3 of the 300 printers in the last example might be active at the same time:

100/30=3.33

Rounding up, the system should include four servers to allow for 100 active printers for a solution with average
execution time below 30 seconds.

Installation overview for an enterprise system
1 Select a system configuration, and then configure the appropriate hardware on the network.

2 Make sure that the time on all computers used in the Lexmark Document Distributor system is synchronized
using a Network Time Protocol (NTP) server.

3 Install the system components.

Note: If you are installing Lexmark Document Distributor using the default database (Firebird), then the
system components can be installed in any order. However, if you are using Microsoft SQL database,
then see “Using Microsoft SQL database” on page 28 before installing LDD.

a Install the database.

b Activate and download licenses on the computer where the load balancer is installed.
¢ Install the load balancer.
d

If you are using one or more Microsoft Cluster Servers, then extend the database and load balancer to
standby nodes.

e |Install servers.
Note: When installing multiple servers, install one server at a time.
4 Change the administrator password. If necessary, change the administrator user name.

5 Temporarily set servers online to test function.

Notes:

* The database requires the most system resources and disk I/O, and therefore should be installed on the
fastest hardware with the fastest disk I/O infrastructure available. Second in resource usage are the
servers.
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® Lexmark Document Distributor components can be installed on virtual servers using VMware ESX 3.0.1
or later. However, the best performance can be achieved only by using separate physical servers.

Using Microsoft SQL database

If you are using Microsoft SQL as the back-end database, then make sure that:

* The Microsoft SQL database is installed before proceeding with the LDD installation. For more information,
see the help information for Microsoft.

Note: To view the list of supported database servers, see “System requirements” on page 16.

* LDD system components are not installed on the server running Microsoft SQL.
® The default database (Firebird) in the LDD installer is not installed.

For LDD to work with Microsoft SQL, create seven databases before the load balancer and server are installed.
To help the database administrator create these databases, do the following:

1 Open the CreateDatabase.sql file located at <installerpath>\mssql\scripts
\CreateDatabase.sql, where <installerpath> is the location of the LDD installer.

2 Modify the script to control the creation of the LDD databases in the Microsoft SQL server, and then save
the file.

Note: The CreateDatabase.sql file contains the minimum database size required for LDD. You can
increase the database size as needed.

3 From the Microsoft SQL server, run the command prompt as an administrator, and then type
sglemd -i <installerpath>\mssgl\scripts\CreateDatabase.sqgl -o <outputfilepaths>\MyOutput.txt

where <installerpaths> is the location of the LDD installer and <outputfilepaths> is the location
where you want to save the log file.

4 Confirm that the databases are installed completely.
a Type sglemd -S . to connect to the default instance.

b Type select name from sys.databases to show all databases.
5 Enable TCP/IP connections and port numbers.

In the SQL Server Configuration Manager, do the following:

a From the Server Network Configuration, make sure that TCP/IP is enabled and the port number is set to
1433.

Note: To check the port numbers for the IP addresses, open the TCP/IP properties.
b From the Native Client Configuration, make sure that TCP/IP is enabled.
Note: You can also migrate data from Firebird to Microsoft SQL. For more information, see the Readme file

for database migration at <InstallCD>\install\mssql migration\readme migration.txt,
where <InstallCD> is the location of the LDD installer CD.
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Installing the database and load balancer without clustering
(configurations 1, 1-N, and 1-1-N)

Installing the database
Note: If you are installing a Microsoft SQL database, then do not install the default database (Firebird).
From the computer where the database is running, do the following:

1 From the installation package, run Setup.exe.

2 From the Lexmark Solutions installation window, click Install Enterprise System > Install Database.
3 Accept the license agreement.

4 If necessary, specify a location for the installation, and then click Next.

Note: The installation path cannot contain double-byte characters.

5 Do one of the following:
® Select the IP address of the computer that runs the database.
® Select IP address only install to use only IP addresses without a reliable DNS.
® Select Restore Install (RI), and then specify or locate the .ri file to install a backup recovery system.

6 Follow the instructions on the computer screen.

Installing the load balancer
From the computer where the load balancer is running, do the following:

1 From the installation package, run Setup.exe.

N

From the Lexmark Solutions installation window, click Install Enterprise System > Install Load Balancer.

w

Accept the license agreement.

D

If necessary, specify a location for the installation, and then click Next.
Note: The installation path cannot contain double-byte characters.
5 Select the IP address of the computer that runs the load balancer.
Note: Select IP address only install to use only IP addresses without a reliable DNS.
6 Type the fully qualified domain name or IP address of the computer where the database is installed.
Notes:

® Do not use localhost or the loopback IP address (127.0.0.1) for the location of the database.

* When installing any configuration other than configuration 1, set the location of the database during
installation. If the database is moved, or the IP address of the database changes for any other reason,
then reinstall the load balancer. For more information on changing the IP address of a Configuration 1
system, see “Changing the IP address on a configuration 1 system” on page 54.

7 Select the type of database, and then click Next.

Note: If you are installing a Microsoft SQL database, then make sure that the database is installed before
proceeding with the load balancer installation.

8 Specify the folder that contains your license files, and then click Next.
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Notes:

® |fthe license files are on a network folder that requires authentication, then you may need to
authenticate it before specifying the license location. To authenticate with the remote server, type
the UNC path (for example, \\myserver\myshare)) in the Run dialog box, and then enter the

credentials when prompted.
® During installation, the license files are copied to the program folder. You can safely move the license
files from the temporary location where you saved them.

9 Ifyou areinstalling a system to recover a backup, then select Restore Install (Rl), and then specify or locate .ri
file.

10 Follow the instructions on the computer screen.

Installing the database and load balancer with clustering (configurations
X-N, and X-Y-N)

Before you begin, make sure that:
® The failover clusters are using Microsoft Windows Server Clustering Services.

* Afirewall is not blocking any physical and logical nodes in the cluster.

Setting up firewall exceptions on a Windows Server 2008 or Windows Server 2012 cluster node

1 Create a temporary directory.

2 From the install\Cluster_Config_Script of the installation package, copy the batch files to the temporary
directory.

3 Run the command prompt as administrator, and then access the temporary directory.

4 Run the batch files.

Note: If you are using a Microsoft SQL database, then do not run the dB firewall batch file.

Installing the database

Notes:

® [f you are using a Microsoft SQL database, then do not install the database component.
® |f you are installing on a Microsoft server cluster, then install Microsoft Visual C++ 2005 Redistributable
Package on all servers in the cluster.

1 From the installation package, run Setup.exe.
2 From the Lexmark Solutions installation window, click Install Enterprise System > Install Database.
3 Accept the license agreement.
4 Specify a location on a shared cluster disk for the installation, and then click Next.
Note: The installation path cannot contain double-byte characters.

5 Do one of the following:
® Select the IP address or host name of the logical host of the cluster.
® Select IP address only install to use only IP addresses without reliable DNS.
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® Select Restore Install (Rl), and then specify or locate the .ri file to install a backup recovery system.

6 Follow the instructions on the computer screen.

Installing the load balancer
1 From the installation package, run Setup.exe.
2 From the Lexmark Solutions installation window, click Install Enterprise System > Install Load Balancer.
3 Accept the license agreement.
4 If necessary, specify a location on a shared cluster disk for the installation, and then click Next.
Note: The installation path cannot contain double-byte characters.
5 Select the IP address or host name of the logical host of the cluster.
Note: Select IP address only install to use only IP addresses without reliable DNS.
6 Type the domain name or IP address of the logical host.
Notes:

® Do not use localhost or the loopback IP address (127.0.0.1) for the location of the database.

® For installation on a cluster, set the location of the database during installation. If the database is
moved, then reinstall the load balancer, or contact Lexmark Professional Services to help modify the
current installation.

7 Select the type of database, and then specify the folder containing the license files.
Notes:

® |f you are using a Microsoft SQL database, then make sure that the database is installed before
proceeding with the load balancer installation.

® [fthe license files are on a network folder that requires authentication, then you may need to
authenticate it before specifying the license location. To authenticate with the remote server, type
the UNC path (for example, \\myserver\myshare\) in the Run dialog box, and then enter the
credentials when prompted.

® [or cluster installation, the folder must contain the license files for all of the cluster nodes with their
appropriate network card MAC addresses.

8 If you are installing a backup recovery system, then select Restore Install (RI), and then specify or locate
the .ri file.

9 Follow the instructions on the computer screen.

Extending the database and load balancer to standby nodes
Do the following on the primary node of each failover cluster:
1 Run the Lexmark Solutions Cluster Configuration script:
In Windows Server 2003

From the install\Cluster_Config_Script folder of the installation package, run the
LexmarkSolutionsClusterConfigScript.vbs script.
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In Windows Server 2008 or later
a Create a temporary directory.

b From the install\Cluster_Config_Script of the installation package, copy either of the following to the
temporary directory:

® LexmarkSolutionsClusterConfigScript_WMIProvider.vbs

® LexmarkSolutionsClusterConfigScript.vbs
€ Run the command prompt as administrator, and then access the temporary directory.
d Run the VBScript file by typing either of the following:

® cscript LexmarkSolutionsClusterConfigScript WMIProvider.vbs

® cscript LexmarkSolutionsClusterConfigScript.vbs

2 Follow the instructions on the computer screen.

Installing servers

Note: When installing multiple servers, install one server at a time.

From the computer where the server is running, do the following:

1 From the installation package, run Setup.exe.

g A W N

From the Lexmark Solutions installation window, click Install Enterprise System > Install Server.
Accept the license agreement.
If necessary, specify a location for the installation, and then click Next.

Do one of the following:

® |f the computer contains multiple network adapters, then select the IP address to bind to the installed
server.

® Select IP address only install to use only IP addresses without reliable DNS.

Type the fully qualified domain name or IP address of the computer or cluster logical host where the
database is installed.

Notes:

® Do not use localhost or the loopback IP address (127.0.0. 1) for the location of the database or
load balancer.

® |[f you are using DNS aliases for connection to a backup system during a recovery, then use the DNS
aliases of the database and load balancer.

Select the type of database, and then click Next.

Note: If you are using a Microsoft SQL database, then make sure that the database is installed before
proceeding with the server installation.

Select Same as Database if the load balancer is installed on the same computer as the database.

Notes:
® |f you want to type the fully qualified domain name or IP address of the computer or cluster logical
host, then clear Same as Database.

* When installing any configuration other than configuration 1, set the location of the database and load
balancer during installation. If the database or load balancer is moved, or the IP address of the
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database or load balancer changes for any other reason, then reinstall the load balancer. For more
information about changing the IP address of a Configuration 1 system, see “Changing the IP address
on a configuration 1 system” on page 54.

9 If you want to set the Global Site Selector (GSS) IP address, then do the following:
a Click Advanced.
b Type the GSS IP address, and then click OK.

Note: You can type a GSS IP address only if all the printers in the system are e-Task 2 or later. GSS is not
supported in e-Task and earlier printers.

10 Follow the instructions on the computer screen.

Note: After all servers are installed, log in to LMC, then change the administrator password, and then set the
servers online.

Antivirus policy requirements and recommendations

Required antivirus policies

® Do not include the following folders when performing real-time virus scanning:

Load balancer server or database server (or only the database server if the load balancer is installed on
another server)

® \Lexmark\solutions\firebird\data
® \Lexmark\solutions\Apache2\logs
® \Lexmark\solutions\Apache2\htdocs\apachewebdav

All Tomcat transaction servers (\Lexmark and all subfolders)

If this is not allowed, the following folders must be excluded:
® \Lexmark\Solutions\tomcat\temp
® \Lexmark\Solutions\tomcat\logs
® \Lexmark\Solutions\tomcat\webapps\webdav and all subfolders
® \Lexmark\Solutions\apps\wf-ldss and all subfolders

Print servers where applicable

® Directory where print jobs are spooled (for example, C:\spool or C:\Windows\system32\spool
\printers)

® Windows temporary directory (C:\Windows\temp)
— Network file shares and subdirectories where solutions installed write files

® Make sure full virus scans and virus definition updates on all Lexmark servers, including load balancers or
databases, application servers, and print servers are scheduled to run during off-peak hours.

Recommended antivirus policy

If you are running the system on a virtualized server environment, then make sure full virus scans and virus
definition updates on all virtual machines on the same virtual machine hosts as the Lexmark virtual machine
servers are scheduled to run during off-peak hours.
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Installing LDD components silently

LDD components may be installed silently using the batch files located in the install
\Silent_Install_Script_Examples folder of the installation CD. Additionally, batch files are included for
uninstallation and cleanup. All batch files included on the installation CD contain usage instructions. The
included batch files are examples for basic setups and may be modified as necessary for your system.

Note: To run an installation script from a network folder, map a drive letter to the network folder. The UNC
path cannot be used when running an installation script.

1 Select the appropriate batch file from the installation package:

Installation batch files

Install_All_on_One_PC.bat—Installs the database, load balancer, and server components on the local
computer for configuration 1.

Install_All_on_One_PC_wo_OCR.bat—Installs all of the LDD 4.x components except for the OCR
engine on the local computer.

Install_Client_Software.bat—Installs client software on the local computer.
Install_Database.bat—Installs the database component on the local computer for configurations 1-1-N
and X-Y-N.

Install_DB_LB_on_One_PC.bat—Installs the database and load balancer components on the local
computer for configurations 1-N and X-N.

Install_LoadBalancer.bat—Installs the load balancer component on the local computer for
configurations 1-1-N and X-Y-N.

Install_LoadBalancer_MSSQL.bat—Installs the LDD 4.x load balancer on the local computer for an
existing Microsoft SQL Server that is configured for LDD. By default, the script uses a Microsoft SQL
named instance with an SQL Server user name and account.

Install_Server_MSSQL.bat—Installs the LDD 4.x Tomcat server on the local computer for an existing
Microsoft SQL Server that is configured for LDD. By default, the script uses a Microsoft SQL named
instance with an SQL Server user name and account.

Install_Server.bat—Installs the server component on the local computer for configurations 1-N, 1-1-N,
X-N, and X-Y-N.

Install_Workgroup_System.bat—Installs an LDD 4.x Workgroup system on the local computer.

Remote_Install_All_on_One_PC_wo_OCR.bat—Installs all of the LDD 4.x components except for the
OCR engine on a remote computer.

Uninstallation and cleanup batch files

clean.bat—Removes files left behind from a previous installation.

Note: Use this file only if there is no other Lexmark software that should remain installed.

Uninstall_DB_LB_Server_on_One_PC.bat—Uninstalls the database and load balancer components
from the local computer.

Uninstall_Server.bat—Uninstalls the server component from the local computer.

2 Atthe command prompt, run the batch file using the switch /? to view the instructions for using the selected

file.

3 Run the batch file again using the appropriate options as shown in the usage instructions.

4 Follow the instructions on the screen.
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Upgrading to LDD 4.8

Notes:

* Make sure that you have LDD 4.6 or 4.7 installed.

® Use the Install Software Updates option in the LDD installation package to upgrade LDD 4.6 or 4.7 to
LDD 4.8. Do not use this option to install a new maintenance release of the LDD 4.8 on an existing LDD
4.8 system (version 4.8.x to 4.8.y or version 4.8.x.m to 4.8.x.n). A patch for existing systems is available
with each maintenance release.

1 From the System tab in LMC, set all servers offline. Click Refresh, and then make sure that of £1ine is
reported in the Status column for each server.

€ Lexmark Management Consolg admin (Logou]

Home | Device Groups | _Safty
s

Notes:

® Any jobs running or queued on a server must be completed before the server goes offline.
® |f a server does not change from the status setting offline after all jobs have been completed,
then restart the server, and then make sure the status of the serveris offline.
2 If the database or load balancer is installed on a failover cluster, then do the following:

a On the primary node in each cluster, close all unnecessary applications, and then make sure no
applications are using the shared drive where LDD components are installed.

b Inthe Cluster Administrator, move all cluster resources to the primary node where the LDD components
are originally installed.

c Stop the cluster service on standby nodes.
Wait for confirmation from the Cluster Administrator that the standby nodes are disabled before
continuing the upgrade.

3 Run the LDD installer.

4 Click Install Software Updates, and then follow the instructions on the computer screen.
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If the database or load balancer is installed on a failover cluster, then do the following:

a On the primary node of each cluster, run the LexmarkSolutionsClusterConfigScript.vbs script from the
install\Cluster_Config_Script folder of the LDD installation package, and then follow the instructions on
the computer screen.

Note: During an upgrade, the clustering script may fail the first time it is run. Run the script a second
time.

b Make sure the Lexmark cluster resources are started.

c Start the cluster service on standby nodes.

6 Reinstall custom components on the servers.

Reinstall all previously installed solutions, including those that were automatically added during a previous
installation.

Notes:

® Solutions created for LDD 4.7 must be updated for version 4.8 using the LDD SDK.

® The solution installation process is different for LDD 4.2 or earlier. Do not use self-extracting installers
that may have been included with earlier solutions. For more information, see “Uploading solutions to
the LDD system” on page 81.

Make sure device groups, software client groups, solutions, and all settings are correct.
From the System tab in LMC, set all servers online.

admin [Logout]
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Export Report | | Refresh | | setOniine | | set Offine

Using Kerberos authentication

If a user logs in at a printer using Kerberos, then the LDD system uses the credentials to manipulate network
files or interact with ECM systems.

Notes:

Enable secure communication between printers and servers in the LMC for any device group that uses a
solution with Kerberos authentication. For more information, see “Enabling secure communication
between servers and printers in a device group” on page 95.

Make sure that the date and time on the printer, LDD server, and KDC server are synchronized.
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Configuring Kerberos authentication on printers
Notes:
® The following procedure applies only to e-Task 2+ printers. If these steps do not apply to your printer,
then see the documentation for your printer.

® The names and locations of the settings mentioned in the following procedure may vary depending on
the firmware installed on your printer.

1 Open a Web browser, and then type the printer IP address.
Note: Locate the IP address from the printer home screen.

2 Click Settings > Security > Security Setup.

3 Under Advanced Security Setup, click Kerberos 5.

Importing a Kerberos configuration file

Importing a configuration file allows more control over Kerberos tickets.
a From the Import Kerberos File section, browse to the krb5.conf file.
b Click Submit to upload the file to the printer.

The following example represents a minimal configuration file:

[libdefaults]

default realm = MY.REALM
kdc _timesync = 1
forwardable = true

[realms]
MY.REALM = {
kdc = MY.KDC.ADDRESS
}

Note: When a configuration file is used, tickets should be marked forwardable by default. Tickets must
be forwardable in order to forward them to the LDD system. For more information about configuration
files, see the Kerberos documentation.

Creating a simple Kerberos configuration file

a From the Simple Kerberos Setup section, type the key distribution center (KDC) address in the KDC
Address field.

b Type the number of the port (1-88) used by the Kerberos server in the KDC Port field. The default is 88.
c Type the realm used by the Kerberos server in the Realm field.
d Click Submit.
4 Add a security template:
a Under Advanced Security Setup, click Security Template.

b Under Manage Security Templates, click Add a Security Template, and then type a security template
name.

c Select the Kerberos_Building_Block authentication setup.
d Click Save Template > Return to Security Setup.
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5 Configure access controls for profiles:
a Under Advanced Security Setup, click Access Controls.
b Apply the security template to all profiles or to a specific profile.

® To apply the security template to all profiles on the printer, including eSF applications, select the
security template that you created beside Use Profiles.
® To apply the security template to an individual profile, do the following:
1 Determine the access control number of the profile.

Note: Keep the Embedded Web Server open while accessing LMC.

a From the Device Groups tab in LMC, select the device group that contains the printer and the
solution.

b Select the Profiles task.
¢ In the main window, select the tab that corresponds to the device class of the printer.
d Find the number beside Access Control.

Note: If 0 appears beside Access Control, then no access control number is
assigned to the profile. For more information, contact your solution provider.
2 From the Access Controls page in the Embedded Web Server, select a security template for the
application corresponding to the access control humber of the profile.

¢ Click Submit.

Depending on the authentication setup, the printer may require user authentication before accessing the
home screen or when accessing an LDD profile from the printer.

Configuring LDD servers for Kerberos authentication

When using Kerberos authentication, you may need to configure Kerberos on each LDD server in your system.

The LDD server requesting a ticket must have the KDC address and realm available in order to request a
Kerberos ticket. Often, the KDC address and realm can be determined from the ticket forwarded from the printer.
Inthis case, no configurationis necessary. Awarningisincluded inthe logindicating that the serveris attempting
to determine the KDC address and realm from a forwarded ticket.

To manually configure each LDD server for Kerberos authentication, do one of the following:

® Create a Kerberos configuration file for the server. This file may be a duplicate of the file uploaded to
configure Kerberos on the printer, but we recommend a minimal configuration specifying only the KDC
address and realm. The configuration file must be named krb5.ini, and it should be placed in the folder
\Lexmark\Solutions\Security where LDD is installed on each LDD server. (You may have to create the
Security folder.)

Note: If you need to read the Kerberos configuration file from another location, see the Apache Tomcat
documentation for more information.

® Setthe KDC address and realm from the script. For more information, see the Lexmark Document Distributor
SDK Guide.
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Monitoring and maintaining the system

Using Lexmark Management Console

Accessing Lexmark Management Console

1 Launch LMC from your Web browser using the URL http://loadbalancer:9780/1lmc, where
loadbalancer is the computer where the load balancer is installed.

The load balancer selects a server to host the LMC session, indicated by a green arrow beside a server in
the Servers list on the Home tab after logging in.

Notes:

On a computer where a server is installed, you can use the desktop shortcut to access LMC.

To access LMC on a particular server, use the URL http://server:9788/1lmc, where serveris
the computer where the chosen server is installed.

It may take several minutes to start all services after the system boots. If LMC cannot be accessed
immediately after booting the system, wait a few minutes, and then try again.

Cookies must be enabled on your Web browser in order to use LMC.

Adobe Flash Player 10 or later is required. If your Web browser settings do not allow ActiveX controls
to run, then you must upgrade manually by visiting the Adobe Web site.

2 Enter the administrator user name and password, and then click Login.

anagement Console  [about] admin [Logout]

roups | Software Client Groups | Devices Solutions | E-Forms | Services | System |

Solutions. Device Groups Software Client Groups

System
H System Status
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Servers
B £ mgier.Irdc.lexmark.ds
I Schedule

Jobs
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| Reports

(%] username & Passwor rd
[ Loap setup

B Licenses

2 privileges

Ll

Messages hide | Licenses: (0) Unlicensed: (0) Discoversd: (0) Missing: (8) Out of Policy: (0) &

Notes:

® The default user name and password are both admin.
® |f LMC is configured to connect to an LDAP server, any valid user name and password may be used.

The Home tab is displayed after a successful login.
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Changing the administrator user name

1 In LMC, click the System tab.

2 Select Username & Password from the System list.

3 Type the new user name.

4 Re-type the new user name to confirm it.

5 Click Apply.

Changing the administrator password

1 Click the System tab.

2 Select Username & Password from the System list.

3 Type the current password.

4 Type the new password, and then re-type it to confirm.

5

Click Apply.

Enabling LDAP server authentication for LMC

The administrator can set up a connection with an LDAP server to authenticate user names and passwords
other than those for the administrator account.

1 Select LDAP Setup from the System list.

H W N

Select the Enable LDAP Authentication check box.
If your LDAP server requires a secure connection, then select Use Secure Connection (SSL/TLS).
Type the LDAP server address and server port.

Note: Port 389 is typically used for non-secure communication, and Port 636 is typically used for secure
communication.

In the User Search Filter field, type the attribute used in the directory to identify a user name, such as cn,
sn, uid, or sAMAccountName.

Inthe User Search Base field, type the relative distinguished name where a subtree search for a user should
begin in the directory, such as ou=Employees.
Do the following to filter the search to users in specific groups:

a Inthe Group Search Filter field, type the attribute used to identify a member of the group, such as member
or uniquemember.

b Inthe Group Search Base field, type the relative distinguished name where a subtree search should
begin in the directory for groups, such as ou=Groups.

c Inthe “Member of Group(s)” field, type a comma-delimited list of group names to search. The user name
must be a member of at least one of the groups listed.

d Inthe Group Identifier field, type a name for the object class.

Note: The object class name can be used to search for the group base when assigning privileges to
groups.
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Example

User Search Filter: uid

User Search Base: ou=Employees

Group Search Filter: uniquemember

Group Search Base: ou=Groups

Group ldentifier: groupO£fNames

Member of Group(s): Dept A,Dept C

If the user name testuser is used to log in to LMC, then the user can be authenticated if each of
the following is true:

— The distinguished name uid=testuser, ou=Employees, o=MyOrganization is found in
the directory.

— The distinguished name cn=Dept A, ou=Groups,o=MyOrganization or
cn=Dept C,ou=Groups,o=MyOrganization is found inthe directory and contains the
attribute uniquemember: uid=testuser,ou=Employees, o=MyOrganization.

— The object class is groupOfNames .

— The correct password is supplied for the user.

8 Select an authentication method:

® |f the LDAP server accepts anonymous connections, then select Anonymous.

® [f the LDAP server requires authentication, then do the following:

a
b

(ot

Select the Username option.

In the Username field, type a distinguished name used to log on to the LDAP server, such as
uid=1dapuser, ou=Employees, o=MyOrganization.

Type the password associated with the selected user name.

9 If you want to test the connection settings, then click Test Settings.

Note: If the LDAP server accepts anonymous connections but you want to authenticate with a user name
and password, then the test cannot determine whether the user name and password are correct. If the
test reports an anonymous connection when you have chosen to use a user name and password, then
you should check the user name and password.

10 In the Search Base field, type the distinguished name where the directory search should begin, such as
o=MyOrganization.

11 Click Save Settings.

Assigning privileges to groups

You can add access control to users accessing LMC. This feature allows you to restrict system access to
authorized groups. The Privileges settings depend on the role assigned to the user.

Notes:

® You need to add a group first before defining privileges. By default, the Default Group is already added
to the group list. This group has access to all tabs and tasks of LMC. The administrator can modify the
privileges of the default group.
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® [f a user belongs to multiple groups, then group privileges are combined. Privileges can be modified for

LDAP users only. The default administrator has access to all tabs and tasks, and these settings cannot
be modified.

1 Select Privileges from the System list.

2 Select a group from the “Group Names from LDAP” list, or add a new group.

To add a group:

a Click Add, then type the first few characters of the group name, and then click Search.
b Select a group name from the list, and then click Add.

3 Select the tabs and tasks the group is allowed to access and perform.

When assigning privileges, you can select specific tasks under each tab.
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add | | Delete save Privileges

Licenses: (0) Unlicensed: (0) Discovered: (3) Missing: (3) Out of Policy: (0)

4 Click Save Privileges to save settings.
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Device Groups tab tasks

Task Operation

Summary

Shows the following information for a selected group:
® A list of solutions deployed for the device group.
® The number of cSF applications.
® The number of discovered, unlicensed, missing, and out-of-policy printers.

® Whether the device group is configured to use a secure communication channel when
submitting jobs. When Secure Server Communication is enabled, communication
between the server and printers associated with the selected group is encrypted.

Some of these values are linked to appropriate tasks that lets you view more information or
change the settings.

When All Device Groups is selected in the Device Groups list, it shows the following
information for each device group:

® A list of solutions deployed

® The number of cSF applications

® The number of discovered, unlicensed, missing, and out-of-policy printers
® Whether Secure Server Communication is enabled

Name*

Lets you change the unique name for the selected group.

Discovery Profiles*

Lets you add, edit, import, and remove discovery profiles used to discover printers.

Discovery

Finds printers on the network that match the discovery profile for each selected group. For
more information, see “Discovering printers” on page 88.

Discovered Devices

Shows the following information for all printers within selected device groups:
® Address
® Host name
®* Model
® Serial number
® Contact name
® Contact location
® Property tag
® |ast discovered date
® Policy last applied date

Unlicensed Devices

Shows the unlicensed printers within the selected device groups. The table contains the same
fields as the Discovered Devices table.

Solutions* Lets you select solutions to deploy to the printers within the selected group. When the
solutions are selected, you can edit local settings for the current device group, and the
solutions are deployed using the Policy Update task.

cSF Apps* Lets you select cSF apps to deploy to the printers within the selected group.

cSF apps are custom applications written using the Cloud Solutions Framework and deployed
from an application server to a supported Lexmark device. For more information, see the
Cloud Solutions Framework SDK Developer’s Guide.

eSF Configuration*

Lets you edit the settings of eSF applications associated with hybrid solutions deployed to
the device group.

* These tasks are not available when All Device Groups is selected.
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Task Operation

Security Setup Files |Lets you manage any printer security setup files within a solution.

Home Screen* Lets you customize the layout of the home screen for the printers included in the device
group. There is a tab for each supported class of printer.

Profiles* Shows the profile settings for the device group for each device class.

Fax Forwarding* Lets you configure MFPs to forward incoming faxes to a fax number, e-mail address, FTP site,
or LDSS. Based on the configuration, you can set the system to manage all incoming fax
requests for processing before the MFP prints and forwards received faxes.

Policy Update Deploys group device policies to printers included in selected device groups.

Out of Policy Lists all out-of-policy printers in the specified device group. The table contains the same fields

Devices as the Discovered Devices table. You can click Update Policy to apply any changes.

Missing Devices Shows the missing printers in the selected device group or groups. The table contains the
same fields as the Discovered Devices table.

Schedule Lets you add, edit, and delete Discovery, Policy Update, and script tasks scheduled to run
for the selected device group or groups.

Security* Enables or disables secure communication between the server and the printers in the device
group.

* These tasks are not available when All Device Groups is selected.

Software Client Groups tab tasks

Task Operation

Summary When an individual software client group is selected, it shows the group name and its list of
solutions.

When All Software Client Groups is selected, it shows the group names and lists of solutions of all
the software client groups in the system.

Name* Lets you change the unique name for the selected group.

Client Profiles* | Lets you add and remove software clients within the selected group.

Solutions* Lets you add, edit, or delete solutions for software clients within a selected group.

Profiles* Shows the profile settings for the software client group.

Schedule Lets you add, edit, and delete script tasks scheduled to run for the selected software client group
or groups.

* These tasks are not available when All Software Client Groups is selected.

Devices tab tasks

The Devices tab is used for maintenance of printers that have already been discovered through the Device
Groups tab. Only discovered printers can be found using the search function on this tab.
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Task Description

Summary When one device is selected, it displays the following device information:
® Address

®* Host name

® List of device groups to which the device belongs
® List of solutions deployed on the device

* Model

® Serial number

® Contact name

® Contact location

® Property tag

® Last discovered date and time

® Unlicensed status

When multiple devices are selected, it displays a table with the same information for each device.
The total number is shown for Device Groups and Solutions and may be expanded to show the
list for each.

Profiles Displays each profile and the associated settings for a selected device

Note: This task shows only one device at a time. When multiple devices are selected, the first
device selected is shown, and other devices may be selected by clicking Next, Previous, or
individual page numbers.

Policy Update |Sends policy updates to selected devices

Missing Identifies any missing devices in the current selection
Devices

Unlicensed Identifies any unlicensed devices in the current selection
Devices

Home Screen | Displays the layout of the home screen on a selected device and provides an interface to edit the
home screen of an individual device

Note: This task shows only one device at a time. When multiple devices are selected, the first
device selected is shown, and other devices may be selected by clicking Next, Previous, or
individual page numbers.

Jobs Displays a sortable table of the jobs for selected devices

Log Displays a sortable table of logged messages for the selected device
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Solutions tab tasks

Task Description

Summary

When an individual solution is selected in the Solutions list, it shows the following information:
® Solution name
® Version number
® |nstall time
® Update time

® Lists of device groups and software client groups to which the selected solution is
assigned

® Lists of formsets, reports, eSF applications, and security setup files included in the solution

When All Solutions is selected in the Solutions list, it shows a table containing the preceding
information about all the solutions deployed on the network.

Configuration”

Adjusts the global settings for the selected solution. The parameters are predetermined for
each solution.

EForms’ Shows a list of the formsets associated with the selected solution.

eSF’ Shows a list of eSF applications associated with the selected solution.

Jobs’ Shows a table of the jobs that use the selected solution.

Log’ Shows a table of the events and messages generated by the selected solution.

Security Setup Files’

Lets you manage any printer security setup files within a solution.

" This task is not available when All Solutions is selected in the Solutions list.

cSF App tab tasks

Description

Summary | When an individual cSF App is selected in the cSF Apps list, it displays the cSF app name, list of device
groups to which the selected cSF app is assigned, cSF App version, WebClient version, install time, and
update time.

When All ¢SF Apps is selected in the cSF Apps list, a table is displayed containing the preceding
information about all the cSF Apps deployed on the network.

E-Forms tab tasks

Description

Form printers Allows you to view and manage the virtual printers that process e-forms

[Formsets Allows you to view and manage formsets for all solutions J
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Services tab tasks

Task Description

Confirm This lets you set the font parameters for all services.

DeviceSecurity | This lets you set the authentication type for security-enabled devices.

E-mail This lets you set the e-mail server parameters.
General This lets you configure the chunk size for device discovery and policy updates.
NPA This lets you set the default port and the timeout periods between retries during device discovery.

PolicyUpdate | This lets you set the policy update parameters, such as the timeout for each device and whether
to overwrite function overrides on the device such as copy or fax.

Reports This lets you configure the e-mail parameters, such as the default sender, receiver, and e-mail
message.
SNMP This lets you configure the SNMP parameters.

System tab tasks

Task Description

System Status | Lists all servers in the system. It also shows the following information for each server:
® Server address

®* Host name

® Status

® License

* Number of running tasks

® CPU usage

® Memory usage

® Network load

® Thread count

® List of installed components and their versions

A green arrow beside the Server Address in the table indicates the server where the current LMC
session is running.

You can also set a server online or offline.

Schedule Shows all script, report, backup and restore, discovery, and policy update tasks scheduled to run
on the system. It also lets you add, edit, and delete scheduled tasks.

Jobs Shows a sortable table of all pending and completed jobs from all printers within the system.

Log Shows a sortable table of event messages generated from all pending and completed jobs from
all printers within the system.

Reports Lets you manage and schedule built-in and custom reports.

Username & Lets you set a new administrator user name and password for LMC.

Password

LDAP Setup Lets you set up a connection with the LDAP server to enable other user accounts.
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Task Description

Licenses Lists all licenses installed on the system. It also shows the feature ID (where the license applies),
expiration date, number of licenses, licenses in use, and license type for each license.

You can also add new licenses to the system.

AP Bundle Lets you update the Advanced Prompting Bundle (AP Bundle) eSF application that e-Task 2
printers require for support.

Specifying updated files here updates the applications on printers during the next policy update.

Privileges Lets you add access control to users.
You can assign privileges to users depending on the group to which they belong.

cSF App Lets you upload your own security certificate for cSF applications that run on printers in an LDD
Certificates system. It secures the communication between the cSF applications running on the printer and
the LDD system.

Finding basic information

Understanding the Home tab

The Home tab provides shortcuts to tasks on the System tab and individual items on other tabs, as well as
indicating the status of each server and device group in the system.

Home tab Description

section

Solutions Lists all solutions available in the system. Clicking a solution in the list links to that solution on the
Solutions tab.

Servers Lists all servers connected to the system. The icon of each server indicates the status of that server.
Clicking a server in the list links to the System Status task on the System tab.

Device Groups | Lists all device groups that have been created. A yellow exclamation mark icon appears on the
icon of a device group that contains out-of-policy printers. Clicking a device group in the list links
to that device group on the Device Groups tab.

Software Client | Lists all groups of software clients connected to the system. Clicking a software client group in the

Groups list links to that group on the Software Client Groups tab.
System Provides shortcuts for all tasks on the System tab. Clicking a task in the list links to that task on the
System tab.

Understanding the status bar

The status bar appears on all tabs and shows the number of licenses, discovered printers, unlicensed printers,
missing printers, and printers known to be out-of-policy, as well as the overall system status. The message bar
above the status bar also appears on all tabs. This area provides feedback when the system setup or device
discovery changes and lists any errors or warnings.
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Status bar item Description

Messages Toggles the message bar by clicking show or hide

Licenses Displays the number of licenses available on the system

Discovered Displays the number of discovered printers currently stored in the database

Unlicensed Displays the number of discovered printers that do not have a license available in the system

Missing Displays the number of previously discovered printers that are no longer responding on the
network

Out of Policy Displays the number of discovered printers known to have settings different from profiles
required by solutions deployed to those printers

System status icon | Indicates the overall status of the system

Progress bar Shows the progress of the current operation

System status information on the status bar and Home tab

The overall system status is indicated by the icon showing three server boxes in the status bar. If any servers
are offline or not communicating, then a yellow exclamation mark icon appears on the system status icon to
indicate the system is operating at reduced capacity. If all servers are offline or not communicating, then a red
X icon appears on the system status icon.

More detailed system status information is available through the System Status task on the System tab. Click
System Status in the System section of the Home tab to access this information.

Viewing information summaries for LDD elements

Summaries of essential information are available for device groups, software client groups, printers, and
solutions.

1 Click the Device Groups, Software Client Groups, Devices, or Solutions tab.

2 Select an item from the list, or when on the Devices tab, perform a search.
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3 Click Summary from the Tasks list.

A summary of basic information about the selected element appears. The summary includes links to find
more information or settings about the included information.

Viewing jobs or system logs

You can view all jobs initiated in the system, including both tasks performed in LMC and print jobs initiated
using a printer or software client. Additionally, a log is available showing any messages reported by jobs, such
as printers discovered during a discovery task. Data for both jobs and logs are saved for seven days.

1 Click the System tab.
2 Select Jobs from the System list to view jobs, or select Log to view logs.
Optionally, apply a filter to the jobs list or log:

® To apply a filter, make selections or entries in the applicable fields, and then click Refresh. If you want
to access less commonly used filter fields, then click Show More Filters.

® To remove a previously applied filter, click Reset Filter, and then click Refresh.

Note: You can also view jobs and logs for specific solutions or printers through the Jobs and Log tasks
on the Solutions and Devices tabs.

While viewing the jobs list, you can view all log entries that apply to a specific job by clicking the task ID of a
job. The log is automatically filtered for the selected task ID. Additionally, to quickly filter the list to view only
jobs in progress, click Running Tasks.

To stop a job, click Stop Task.

To refresh the jobs list or log, click Refresh. To set the jobs list to automatically refresh on a timed interval,
select the Auto Refresh option, and then select a time interval.

To change the number of entries that appear on each page of the jobs list or log, select a new value for Number
of Jobs/Page.

To export the jobs list or logs in comma-separated values (CSV) format, click Export Report.

Customizing columns for jobs and system logs
1 Click the System tab.

2 Select Jobs or Log.

3 Click Customize Table.

All columns are shown by default.

4 From the Customize Jobs Table or Customize Log Table, adjust the columns as necessary:
® To remove a column from view, select it in the Current Columns list, and then click Remove.

® To add a column back to the Current Columns list, select it in the Available Columns list, and then click
Add.
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® To adjust the position of a column, select it in the Current Columns list, and then click Move Up or Move
Down.
® To return all columns to view in the default order, click Reset.

5 Click OK to save your changes, or click Cancel to keep the current view.

Custom selections for columns are saved in a cookie in your browser so they are available each time you
use LMC.

Viewing device group profile settings

1 Click the Device Groups tab.

2 Select a device group from the Device Groups list.

3 Select Profiles from the Tasks list.

4 In the main section, select the desired Device Class tab.

5 Select a profile name to display the settings.

Viewing software client group profiles

1 Click the Software Client Groups tab.

2 Select a software client group from the Software Client Groups list.

3 Select Profiles from the Tasks list.

Viewing forms associated with a solution

Solutions that include forms merge functionality are associated with forms that are installed along with the
solution.

1 Click the Solutions tab.
2 Select a solution from the Solutions list.

3 Select EForms from the Tasks list.

Viewing version information

You can view version numbers for all system components, which may help you to troubleshoot problems and
make sure all components are up to date.

1 Click the System tab.
2 Select System Status from the System list.

3 In the Components column, click Version Info. You may have to scroll to the right to see the Components
column.

To export component version information along with system status information, click Export Report in the
System Status window.
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Managing the LDD system

To perform system tasks, such as creating reports on the overall performance of the system, setting servers
offline, changing the administrative user name and password, or viewing the overall job schedule, use the
System tab in Lexmark Management Console.

Viewing and changing server status

To view server status, click the System tab, and then select System Status from the System list.

Atable is displayed with information about each server in the system. The Status column indicates whether the
server is online, offline, or has a communication problem. A yellow exclamation mark icon appears beside the
status when the server is offline, and a red X icon appears to indicate a communication problem.

Note: Multiple non-communicating servers may impact system performance. If you do not expect a
non-communicating server to quickly reestablish communication, you should remove it.

The server on which the current LMC sessionis running is indicated by a green arrow beside the Server Address.

You can perform the following tasks:

® To change the online status of a server, select the check box of a server from the table, and then click Set
Online or Set Offline.

® To export all system status information and component version information, click Export Report.

®* To remove a server that is not communicating, select the check box beside it in the table, and then click
Remove Server(s). If the server later reestablishes communication, it automatically reappears in the server
list.

Viewing and managing scheduled tasks

To access a list of all scheduled discovery, policy update, and script tasks for all device groups and software
client groups, select Schedule from the System list on the System tab.

From this list, you can perform the following actions:
* Add a new task—Click Add.
¢ Edit an existing task—Select the existing scheduled task you want to edit, and then click Edit.
Note: You cannot change the task type for an existing task.
* Delete an existing task—Select the existing scheduled task you want to delete, and then click Delete.

Do the following when adding or editing a task:
1 If you are adding a new task, then select a task to schedule.
2 Edit the description of the task, and then click Next.

3 If you are adding or editing a script task, then select whether to associate the scheduled script with a device
group or software client group to access the local solution settings of that group:
® To associate the script with a device group, click DeviceGroup, and then click Next.
® To associate the script with a software client group, click SftClientGroup, and then click Next.

® To schedule the script without associating it with a device group or software client group, click None,
and then click Next.
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4 Continue configuring the selected task:

If you are adding or editing a discovery or policy update task, then select the device groups for which
the task is performed, and then click Next.
If you are adding or editing a script task, then do the following:

a Select the device group or software client group for which the task is performed, and then click
Next.

Note: You can only select one device group or software client group for a script task.
b Select the solution that contains the script you want to run.
€ Select the script to run, and then click Next.

If you are adding or editing a report task, then select and configure the report to run, and then click
Next.

If you are adding or editing a backup and restore task, then type the Backup Share Path and the
credentials required to access the specified share, and then click Next.

5 Configure the date, time, and frequency information for the task.

6 Click Finish.

Configuring the confirmation page

When a job is completed, a confirmation is automatically delivered through a printout or e-mail message unless
it is disabled within a particular solution. These settings determine the type of confirmation, how it appears,
and, if it is an e-mail message, to whom it is sent.

1 Click the Services tab.

2 Select Confirm from the Services list.

3 Select Parameters from the Tasks list.

4 Select the lowest level of messages to include in confirmations:

debug—This includes detailed messages used to diagnose problems, as well as other lower message
levels than this level.

info—This includes messages that indicate successful job activities, as well as other lower message
levels than this level.

warn—This includes messages that indicate potential problems, as well as other lower message levels
than this level.

error—This includes messages that indicate unsuccessful job activities, as well as other lower message
levels than this level.

fatal—This includes only messages that indicate complete failure of jobs.

5 Select a task from the “Task used to deliver confirmation page” list:

confirm.printPS—This prints a confirmation page in PostScript format.
confirm.printPDF—This prints a confirmation page in PDF format.

confirm.emailAdmin—This sends a message to the administrator e-mail address with a PDF confirmation
page attached.

confirm.emailAdminTextOnly—This sends a message containing the confirmation information to the
administrator e-mail address with no attachments.
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Note: The e-mail service must be correctly configured to use confirm.emailAdmin or
confirm.emailAdminTextOnly.

6 |If you are using e-mail confirmations, then type the address where e-mail confirmations are sent in the
“Admin email address” field.

7 Type a page title to appear on the confirmation page or message.
Edit the remaining parameters to determine the font settings for the title and page text.

9 Click Apply.

Adding servers to the system after initial installation

New servers may be added to an existing system to increase capacity, or servers may be replaced without
reinstalling other components. When a new server is installed on a system that already has solutions, the
solutions and all associated settings are added to the new server. However, any third-party services used with
existing solutions must be installed manually. If the new server is left without the same services as existing
servers, any jobs that use the solution that is missing services on the new server will fail.

1 Addthe computer where the server will be installed on the network, and make sure the time is synchronized
using an NTP server.

2 Install the server. For more information, see “Installing servers” on page 32.

Install any third-party services required by existing solutions on the new server.

From the System tab in LMC, set the new server online. For more information, see “Viewing and changing
server status” on page 52.

Changing the IP address on a configuration 1 system

If an incorrect IP address or fully qualified domain name is used when installing a configuration 1 system, or the
IP address of the computer on which the components of a configuration 1 system are installed changes for any
reason, then the IP address of the components can be changed without reinstallation.

1 From the command line on the computer where all components are installed, navigate to the Lexmark
\Solutions\InstallHelper folder in the location where the components are installed. (The default is C:\Program
Files\Lexmark\Solutions\InstallHelper.)

2 Type update-addr.bat -hostname to use the fully qualified domain name of the local computer, and
then press Enter

or

Type update-addr.bat -ip to use the IP address of the local computer, and then press Enter.

3 The desktop shortcut must be changed to the new address manually:

a On the desktop of the computer where the components are installed, right click the Lexmark
Management Console (LMC) icon, and then click Properties.

b Click Find Target.
In the folder that appears, right click the shortcut Ime, and then click Properties.

d Change the IP address or host name part of the URL to the new IP address or host name of the local
computer. The complete URL shouldbe http://hostname: 9780/1lmc/, where hostname is the host
name or IP address of the computer where the components are installed.
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Rebooting the LDD system
1 Click the System tab.

2 Set all servers offline. For more information, see “Viewing and changing server status” on page 52.
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3 Shut down all server computers, load balancer computers, and database computers.
4 Boot the database computers, load balancer computers, and server computers.

Note: You can boot the server components in any order.

5 Fromthe Systemtab in LMC, set all servers online. For more information, see “Viewing and changing server
status” on page 52.

3
Systom systel, ﬁ)
Svotom SEaEE

sehedie = Sisiess | T I
b5 5 [buwiseoss  |10.100000 i

& offine
Log

Reports

Username & Passwort d System Health.

Export Report. | | Refresh | | setoniine | | set oOffline
LDAP Setup

B sServer handling this LMC session
Licenses

€ Lexmark Management Consolg admin [Loaout]
7] .
Home | Device Groups | _Softw ‘ Devices | Solutions | E-forms | Services | System |
B

I

4P Bundle i\ Server is currently offline
Privileges ® server is not communicating

B server s unicensed

Note: It may take several minutes to start all services when the LDD system is first booted. If LMC cannot
be accessed immediately after booting the system, then wait a few minutes, and then try again.

Restarting the Lexmark Solutions Application Server

If you install a workflow solution that includes a component, then you may need to restart the Lexmark Solutions
Application Server for the solution to fully function.

Before restarting the Lexmark Solutions Application Server, set the server offline on the System tab in LMC.

Make sure the server is offline before proceeding. Click Refresh, and then make sure off1line is reported in
the Status column for the server.
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You can restart the Lexmark Solutions Application Server from the Windows Services control panel.

Note: When you restart the Lexmark Solutions Application Server service, any solution-related file in the
\Lexmark\Solutions\apps\wf-ldss\ or \Lexmark\Solutions\apps\wf-ldss\solutions folders, such as a property
file for a solution, is reverted to the version stored with the solution package as it was initially installed or
upgraded, and any manual changes are lost.

Uninstalling LDD components
1 Click the System tab.

2 Set all servers offline. For more information, see “Viewing and changing server status” on page 52.
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Notes:
® Make sure all servers are offline before proceeding. Click Refresh, and then make sure offline is
reported in the Status column for each server.
® Any jobs running or queued on a server must be completed before the server goes offline.

® |f a server does not change from the status setting of£fline after all jobs have been completed,
restart the server computer, and then make sure the status of the serveris offline.

3 If the database or load balancer is installed on a failover cluster, then do the following:

a Onthe primary node in each cluster, close all unnecessary applications, and make sure no applications
are using the shared drive where LDD components are installed.

b Inthe Cluster Administrator, move all cluster resources to the primary node where the LDD components
are originally installed.

c Stop the cluster service on standby nodes.

Wait for confirmation from the Cluster Administrator that the standby nodes are disabled before
continuing the upgrade.

4 From the computer where the component(s) are installed, do the following:
a Click Start.
b Click Programs or All Programs.

¢ Click Lexmark > Solutions Software Uninstall.

Note: If a database or load balancer is installed on a failover cluster, then use the node where the
component is originally installed.
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5 Select the components to uninstall, and then click Finish.

6 Allow the process to complete, and then click Done.

Updating the Advanced Prompting Bundle

The Advanced Prompting Bundle (AP Bundle) is an eSF application that LDD installs on e-Task 2, e-Task 2+,
e-Task 3, and e-Task 4 multifunction and single-function printers, and X642 printers. This application is required
for LDD support and provides prompting capabilities, held jobs support, and security support for printers with
LDD.

1 Click System tab > AP Bundle.

2 Beside AP Bundle Application File, click Browse, and then locate the file ap-x.x.x.x.fls.

3 Beside AP Bundle Descriptor File, click Browse, and then locate the file ap-x.x.x.x_desc.xml.
Notes:

® The descriptor file is required in order to update the AP Bundle.
® You can change the default settings of the AP Bundle application on e-Task 2+ printers by editing the
value attributes of the property elements in the descriptor file. Adding or removing settings in the
descriptor file does not affect the application.
4 Click Upload.
During the next policy update, LDD updates the AP Bundle application on printers where it has not been
installed or when an older version is installed.

Note: If a printer already has a newer version of the AP Bundle application installed, then the version
specified for the update is not installed.

Managing system performance

Accessing the System Health dashboard

1 Click the System tab.
2 Select System Status from the System list, and then click System Health.

Monitoring system health

The overall system health is shown in the top section of the page by the following indicators:
® Overloaded—The indicator changes color depending on the overload condition of the system:
— Green—No servers are overloaded, and all servers are operating at normal capacity.

— Yellow—One or more servers are overloaded, but at least one server is not. Overloaded servers operate
at diminished capacity until they are no longer overloaded.

— Red—All servers are overloaded and operating at diminished capacity.
® Tasks / hour—This displays the current hourly task rate, based on tasks done in the past minute.

* Threshold exceptions—This displays the hourly rate of tasks that exceed the threshold time set for each
job on each server, based on tasks done in the past minute.
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To view the performance data for an individual server, select the address of the server from the listin the Server
Health section. The following data are shown for overall server performance:

® Task Count—This displays the number of jobs running on the server over time.

® Overload / hour—This displays the hourly rate of overload events. An overload event occurs when more
tasks are sent to the server than the currently configured design load and ends when the number of tasks
is reduced to the currently configured recover load.

Note: For more information about design load and recover load, see “Tuning the load balancer for
unequal servers” on page 59.

The following task-specific data are shown for the task selected from the list:

® Task / hour—This displays the current hourly task rate for the selected task, based on tasks done in the
past minute.

* Threshold exceptions / hour—This displays the hourly rate of task that exceed the threshold time set for
the selected task, based on tasks done in the past minute.

Note: To change the threshold time for the selected task on the selected server, type a new value
beside “Set threshold (seconds),” and then click Apply.

To zoom in any of the performance graphs in the Server Health section, click the graph. Click the graph again
to return to the view of all graphs.

Notes:

® Each time a graph reaches a significant number of data points, each two points are averaged, and then
new data is recorded as normal until the maximum number of data points is again reached.

® The slider controls at the bottom of the page are used to tune system performance. For information
about these controls, see “Tuning the load balancer for unequal servers” on page 59 and “Adjusting
limits on concurrent jobs” on page 58.

Adjusting limits on concurrent jobs

A server that meets recommended requirements is tested to process 30 concurrent jobs from clients. If a server
is faster than the recommended system, then you may be able to raise the limit on concurrent jobs for that
server to increase system capacity. If a server is slower than the recommended system, then you may need to
lower the limit on concurrent jobs to maintain system reliability.

Warning—Potential Damage: Setting high limits on concurrent jobs could cause failures with some
solutions, including out of memory errors, timeouts, very slow system response, and database failures.
Make sure databases are properly backed up before raising limits for concurrently running tasks.

The adjustment shown here sets the baseline design load for the server. Additionally, a recover load is set at
80% of the design load. When the jobs running on the server exceed the design load, the server is considered
to be overloaded, and the load balancer reduces job submissions to the server until the recover load is reached.

Do the following for each server for which you want to change the limit on concurrent jobs:
1 Fromthe System Health dashboard, selectthe address ofthe server from the list in the Server Health section.
2 Adjust the Concurrently Running Task Limit slider to the desired limit for the server.

Note: These settings are not saved during an upgrade. If you upgrade your system, then you must repeat
these steps.
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Tuning the load balancer for unequal servers

When all servers in the system are approximately equal, server loads should be optimal without manually tuning
the load balancer. However, when servers are unequal, the least powerful machine determines the overall
throughput unless you compensate by manually assigning a load balancing factor to each server. Since more
powerful machines can run more concurrent jobs and complete each job in less time, routing more traffic to
them increases the overall job capacity of the system.

The load balancer component is composed of three different Tomcat load balancing workers that separately
manage Lexmark Management Console (LMC) sessions, job submissions from e-Task 2 and e-Task 3 printers,
and job submissions from e-Task printers. The adjustment shown here affects the e-Task 2, e-Task 3, and
e-Task load balancers, but not the LMC load balancer. Each load balancer distributes jobs to servers in
proportion to the load balancing factors assigned to each server. For example, in a system with three servers
with load balancing factors of 10,10, and 20, the first two servers each receive 25% of jobs, and the third receives
50%.

The ideal job distribution depends on the hardware, network environment, and the solution being run. The
optimal proportions for load balancing factors can be found by running performance tests on each server.
However, some factors such as memory, number of processors, or CPU speed may suggest an initial value for
the load balancing factor to add more system capacity. Note, however, that performance improvements are
not linear functions of numerical improvements in hardware.

Perform the following steps on each server after initial values are determined for load balancing factors:
1 Fromthe System Health dashboard, selectthe address ofthe server from the list in the Server Health section.
2 Adjust the Load Factor slider to the desired load balancing factor for the server.

Note: These settings are not saved during an upgrade. If you upgrade your system, then you must repeat
these steps.

Assigning servers to only run LMC or process jobs

When using more than one server in a system, you can assigh some servers to only run LMC and other servers
to only process jobs. When all servers are separated in this manner, it is usually adequate to assign only one
server to run LMC.

When using a configuration 1-N, X-N, or X-Y-N system with the recommended hardware, it is recommend to do
the following:

® |nstall the server component on the RAID 1array where the operating system is installed on the load balancer
computer, and configure it to only run LMC.

® Configure servers installed on dedicated computers to only process jobs.
1 Launch JK Status Manager from your Web browser using the URL http://loadbalancer:
9780/status/?opt=454, where loadbalancer is the computer where your load balancer is installed.

Server information and the worker status for each of the three load balancing workers appear. Each server
in the system is listed as a worker in each Balancer Members list.

2 For each server that should only process jobs, stop the associated worker on the adminloadbalancer load
balancing worker, which balances requests to LMC:

a Inthe “Worker Status for adminloadbalancer” section, click E beside the server name.
b For Activation, select the Stopped option.
¢ Click Update Worker.
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3 For each server that should only run LMC, stop the associated worker on the clientloadbalancer and

adaptorloadbalancer load balancing workers, that balance job requests:

a Inthe “Worker Status for clientloadbalancer” section, click E beside the server name.
b For Activation, select the Stopped option.

¢ Click Update Worker.

d Repeat these steps for the same server in the “Worker Status for adaptorbalancer” section.

Notes:

® Make sure at least one server is assigned to run LMC and at least one server is assigned to process jobs.
® Changing other load balancer and server properties is not recommended in most cases.

Configuring chunk size for device discovery and policy updates

When using three or more servers, reducing the chunk size may increase the speed of device discovery and
policy updates.

1 Click the Services tab.
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Select General from the Services list.
Select Parameters from the Tasks list.

In the ChunkSize field, type a new value. When using three or more servers, a value as low as 2 may be
appropriate.

Click Apply.

Configuring communications

Configuring connection to an SMTP server

0 N O Ul A W N o

Click the Services tab.

Select Email from the Services list.

Select Parameters from the Tasks list.

Type the password and user ID used to log on to your SMTP server.
Type the e-mail server connection timeout in seconds. The default is 60.
Type the e-mail server host name or IP address.

Enter the e-mail server I/0 timeout in seconds.

Click Apply.
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Configuring NPA device communication

Though the default port is usually used for NPA device communication, the timeout periods between retries
can be changed to improve reliability during device discovery.

1 Click the Services tab.

2 Select NPA from the Services list.

3 Select Parameters from the Tasks list.

4 Type the port number used for NPA on your network in the Unsecure Port field. The default setting is 9300.

5 Type atimeout period in milliseconds for each retry in sequence, separating each by a space in the NPANT
Timeout field. The default settings are 1000 and 5000.

6 Click Apply.

Configuring SNMP for discovering printers

Click the Services tab.

Select SNMP from the Services list.

Select Parameters from the Tasks list.

In the Port field, type the port number used for SNMP on your network. The default is 161.

In the Write Community Name field, type the write community string for printers on your network.
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In the Timeouts/Retries field, type a timeout period in milliseconds for each retry in sequence, separating
each by a space.

In the Read Community Name field, type the read community string for printers on your network.

N

8 Click Apply.

Configuring device security

To enable communication with Basic Security template—enabled devices, make sure the Basic Security
template matches the authentication type and the password or PIN configured in LMC. Only authentication
through password or PIN is supported.

1 Click the Services tab.

2 Select DeviceSecurity from the Services list.

3 Select Parameters from the Tasks list.

4 Select the type of authentication for the device, and then type the password or PIN.

5 Click Apply.
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Managing licenses

Adding licenses to an existing server

Note: Back up your current license files before updating with new files. To obtain the new license files,
contact your Lexmark representative.

1 From the System tab in LMC, click Licenses > Add License.
2 Browse to the license file, and then click Upload.

Note: Uploading license files copies them to the program folder. You can safely move the license files
from the temporary location where you saved them.

Using the Solution Status Page

Some solutions include a Solution Status Page that provides simple and easy-to-use access to status information
for the server system where the solution is running and the printers in the device group associated with the
Solution Status Page. Additionally, new printers and licenses can be added, and a single Fix button can fix many
common problems. The Solution Status Page is particularly suited to less-experienced users.
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Note: The Solution Status Page can only be enabled for solutions designed for device groups.

Accessing the Solution Status Page

Launch the Solution Status Page from your Web browser using the URL http://loadbalancer:
9780/1lmc/statuspage/?solutionName=solutionname, where loadbalancer is the computer
where your load balancer is installed, and solutionname is the name of the associated solution.

Understanding status information

Note: The following section titles and fields may have been customized for your solution and may differ from
the text shown here.
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Server Status

The Server Status section provides basic information about the server system and indicates any problems
related to the server system itself.

CORADCN
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Evaluation [Expenes in 110

dryi)
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Field Description
Name The host name of the computer where the server system is running
Status Indicates whether the server system is online or offline
Configuration Indicates the current status of the server configuration
License Indicates the type of license, if any, that is provided for the server

MFPs (overview)

The MFPs section in the left pane shows the overall status of the printers connected to the server.

Toksl HFPs: 1]
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Liceread o
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110 days)
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Field Description

Total Stations Indicates the number of printers connected to the server system

Not Communicating | Indicates the number of printers that are not responding to the server system

Licensed Indicates the number of printers connected to the server that have licenses available on the
server system

Unlicensed Indicates the number of printers connected to the server that do not have licenses available
on the server system. Solutions will not function on printers added that exceed the number
of licenses available.

Remaining Licenses | Indicates the number of licenses available for connecting more printers to the server system
. J

Jobs

The Jobs section provides an overview of jobs run on the connected printers.

Compleind

Fadexd ]

] *

Field Description

Running Indicates how many jobs are currently being processed on all connected printers

Completed | Indicates how many jobs have been successfully processed on all connected printers since the server
was installed
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Description

Failed Indicates how many jobs failed to successfully complete on all connected printers since the server was
installed

Canceled |Indicates how many jobs were canceled by the user on all connected printers since the server was
installed

MFPs (detail)

The MFPs section in the right pane lists each connected printer. Expand a printer in the list to show the following
information:

Field Description

Configuration Indicates the current status of the printer configuration

Licensed Indicates whether the printer has a license available on the server

State Indicates the current status of the printer and any errors reported by the printer

To filter the list of printers by status, select an option from the Filter list.
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110 days]

Completed:
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Repairing common server problems

Click Fix to repair several common problems that occur in the system.
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The Fix button does each of the following as necessary:
® Set all servers online.
® Run a discovery for the associated device group.
® Update policies on associated printers.

Reload the license files on the server system.

Printers that are powered off when using the Fix button are placed in the Not Communicating category. To
recover communication with a printer in the Not Communicating category, turn on the printer, and then click
Fix again.

Adding printers to a server

Adding a printer using the Solution Status Page adds the printer to the device group associated with the solution
and runs a discovery to initiate communication with the printer. Each printer added uses one of the available
licenses on the server.

1 Make sure the printers being added are turned on.
2 Inthe right pane of the Solution Status Page, click Add.

Note: The Add button is available only if the server has unused licenses.
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3 Type the IP address or host name of the printer, and then click Add.

The printer is added to the MFPs list in the right pane, and the numbers in the MFPs section of the left pane
are adjusted accordingly.

4 Click Yes to add another printer, or click No to complete the process.

Adding licenses to a server
You can add both server licenses and MFP licenses from the Solution Status Page.

1 Select the type of license to add:
® To add a new server license, click Add a Server License.
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® To add a new printer license, click Add a MFP license.
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2 In the window that appears, type a path to a license file, or click Browse to browse to the license file.

LAodRLRemore.

3 Click Upload.

Removing printers

Removing a printer disables the solution on that printer and frees a license on the server.
1 In the right pane of the Solution Status Page, select a printer to remove.

2 Click Remove.

3 Click Yes to confirm.
The printer is removed from the associated device group, and its license is made available.

Managing reports

Running a report

Note: It is recommended to run reports during off-peak usage times to avoid affecting system performance.
1 Click the System tab.

Select Reports from the System list.

Select a report from the Available Reports list.

Specify the reporting period.
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Select an output format from the Output Format drop-down menu.

Note: Each report has a default selection for the output format, which may be the format that the report
was specifically designed to use. For more information about a custom report, contact the designer of
your custom report.

6 Save the report to a file or send it in an e-mail message:
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To save the report to a file:

a Selectthe Save To check box.

b Click L. beside the Save To field.

c Type a destination folder path using either a local drive letter or a UNC path for a network share.

d Ifthe folderis located on a network share that requires authentication, then type the network share user
name and password.

e Click OK.

To send the report in an e-mail message:
a Select the Email To check box.

b Click L. beside the Email To field.

¢ Edit the fields of the e-mail message as necessary, and then click OK.

7 If additional query parameters are available for the selected report, then click Additional Parameters to
specify values for those parameters. If no additional parameters are available, then the button is disabled.

Note: Additional parameters can be defined only when including a report with a workflow solution during
development. For more information, see the Lexmark Document Distributor SDK Guide.

8 Click Run Report.
The report is displayed in a new window and may be saved to a file or sent in an e-mail message.

Notes:

® Only summary reports are supported. Even if a custom report has a detail section defined, the section
is not displayed. If a custom report does not have a summary section, then the finished report is
blank.

® Pop-ups must be allowed for LMC in your Web browser to view reports.
® Adobe Reader is required to view PDF reports.

Scheduling a report

Note: It is recommended to run reports during off-peak usage times to avoid affecting system performance.
1 Click the System tab.

2 Select Schedule from the System list.

3 Click Add > Report.

Note: Some solutions may include a script that runs a report with a predetermined configuration which
can be scheduled like any other script. Additionally, reports that run through a script can be run
separately for each server in the system. For more information, contact the developer of your solution.

4 Type a description for the task, and then click Next.

5 Select and configure the scheduled report:
a Select a report from the Available Reports list.

b Select a reporting period.
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6
7
8

Cc Select an output format from the Output Format drop-down menu.

Note: Each report has a default selection for Output Format, which may be the format that the report
was specifically designed to use. For more information about a custom report, contact the designer
of your custom report.

d Save the report to a file or send it in an e-mail message:

To save the report to a file:
1 Select the Save To check box.
2 Click L] beside the Save To field.
3 Type a destination folder path using either a local drive letter or a UNC path for a network share.
4

If the folder is located on a network share that requires authentication, then type the network share
user name and password.

5 Click OK.

To send the report in an e-mail message:
1 Select the Save To check box..
2 Click L) beside the Email To field.

e If additional query parameters are available for the selected report, then click Additional Parameters to
specify values forthose parameters. If no additional parameters are available, then the button is disabled.

Click Next.
Enter a start date and a start time.

Configure the frequency of the scheduled event, and then click Finish.

Using built-in reports

Built-in reports are available to display commonly used data. All built-in reports are designed for PDF output,
except for those that specify CSV in the report title.

Jobs Report - CSV—This displays the jobs list in CSV format.

Log Report - CSV—This displays all log entries in CSV format.

Log Report - Failed Jobs—This displays log entries for failed jobs.

Printer Report—This displays data related to printer usage, such as printer success rates, printer model
usage, printer usage per profile, and most active users per printer.

Report by Time—This displays daily and hourly data, such as job totals, job success rates, printer usage,
user usage, server usage, and job durations.

Server Report—This displays data related to server usage, such as job success rates, hourly job rates, job
duration, and server distribution. Both a summary for all servers and details for individual servers are
available.

Software Client Report—This displays data related to software client usage, such as software client success
rates, software client usage per profile, and most active users per software client.

Solution Report—This displays data related to solution usage, such as solution success rates, most used
solutions, and how solutions are accessed.

Task Summary Report—This displays data related to tasks, such as task attempts, task success rates, and
task times. Both a summary and details are available.
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®* Tops Report—This displays the most active of the following elements:

Users

Printers

Printer models

Profiles

User for each profile
Servers

User for each printer
Software client for each profile
User for each software client
Tasks

Printer for each profile
Scheduled scripts

® User Report—This displays data related to users, such as user job success rates, most active users, and job
duration.

Adding a report

Note: Only summary reports are supported. Even if a custom report has a detail section defined, the section
will not be displayed. If a custom report does not have a summary section, then any reports generated from
the custom report will be blank.

1 Click the System tab.

2 Click Reports in the System list.

3 Upload the report files:

a
b

Click Upload Report Files > Browse.

Select a jasper compiled report file, as well as any of the following:
® jasper compiled report files used as subreports
® .jpg or .png graphics included in the report
® jrxml report source files (optional)

Click Open.

Existing files are overwritten by default. If you do not want to overwrite existing files, then clear the
Overwrite if file already exists check box.
Click Upload.

Selected files are copied to the folder \Lexmark\Solutions\apps\wf-ldss\WEB-INF\reports\ where the
system is installed on each server.

4 Below the Available Reports list, click Add.

5 Type a descriptive report name.

6 Select the Jasper report file name for the compiled report you uploaded.
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7 Select the database the report was designed to access from the Datasource drop-down menu. Commonly
used databases include:

* MONITOR—This is used by reports that access the jobs list and the log.
® SOLUTIONINFO—This is used by some solutions to store custom data.
For more information about a custom report, contact the designer of your custom report.
8 Select the default output format.

Note: Each report has a default selection for output format, which may be the format that the report was
specifically designed to use. For more information about a custom report, contact the designer of your
custom report.

9 Click Save.

Editing report settings

1 Click the System tab.

2 Click Reports in the System list.

3 Select a report from the Available Reports list, and then click Edit.

4 Edit the report settings as necessary:
® Type a descriptive report name.
® Select the Jasper report file name for a compiled report that has been uploaded to the system.
® Select the data source.
® Select the default output format.

Note: Each report has a default selection for output format, which may be the format the report was
specifically designed to use. For more information about a custom report, contact the designer of
your custom report.

5 Click Save.

Removing a report
To remove a report, select a report from the Available Reports list, and then click Delete.

Note: Removing a report automatically removes any associated scheduled report tasks. However, any
scheduled script tasks that use the report are not detected and must be removed manually.

After removing a report from the Available Reports list, you can optionally delete associated files from the folder
\Lexmark\Solutions\apps\wf-ldss\WEB-INF\reports\ where LDD is installed on each server.

Configuring default report options
You can configure default report options, such as default e-mail or file destination and default reporting period.
Select the Reports service from the Services tab.

Clicking Refresh Defaults while configuring a report returns settings to defaults.
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Creating custom reports

LDD uses JasperReports for custom reports. You can create custom reports using the open source application
iReport 3.5.2, available from http://jasperforge.org/ireport. For more information about overall report design,
see the documentation for iReport.

Note: Only summary reports are supported. Even if a custom report has a detail section defined, the section
will not be displayed. If a custom report does not have a summary section, any reports generated from the
custom report will be blank.

Using special LDD parameters
You can add the following parameters to the report design in order to use the specified information in other
parts of the report:

®* start date—This retrieves the start date for report data, as specified in a script or by the administrator
when the report is run.

* end date—This retrieves the end date for report data, as specified in a script or by the administrator when
the report is run.

® SUBREPORT DIR—This retrieves the reports folder, located at \Lexmark\Solutions\apps\wf-ldss\WEB-INF
\reports\ where LDD is installed on each server, from the LDD installation in order to locate subreport files.

Note: Additional parameters can only be added when a report is developed and uploaded with a solution
using the SDK. For more information, see the Lexmark Document Distributor SDK Guide.

Querying the database

Information for built-in reports and many custom reports are retrieved from the MONITOR database, which
contains information about tasks. Custom reports may also retrieve information from the SOLUTIONINFO
database, where some solutions store custom data.
The credentials for Firebird databases are as follows:

¢ User name—framework

* Password—rivet
Information that appears in the log is available from the TASK_LOG table in the MONITOR database. It contains
the following fields:

® ID—A unique ID number assigned to each entry in the log.

® LOG_TIME—The time when an entry was added to the log.

® STATUS—The status reported by the solution that added the log entry.

* PERCENT_COMPLETE—The progress reported by the solution that added the log entry.

* TASK_MESSAGE—The log message reported by the solution.

® TASK_ID—The unique ID number assigned to a task. Each entry recorded from the same task has the same

TASK_ID.

Information from the Jobs list is available from the TASK_INFO table in the MONITOR database. It contains the
following fields:

® TASK_ID—The unique ID number assigned to the task.

* HOST_NAME—The host name of the server where the job was run.

* TASK_NAME—The name of the task.
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®* SOLUTION_NAME—The name of the solution where the task was run.

® STATUS—The status reported when the job was completed or abandoned.

* START_TIME—The time when the job was received.

e END_TIME—The time when the job was completed or abandoned.

* PERCENT_COMPLETE—The progress reported by the job when it was completed or abandoned.
® USER_ID—The user who submitted the job (if applicable).

* PRINTER—The address of the printer or software client that submitted the job (if applicable).

* ADDRESS—The unique ID number of a printer.

® SCHEDULE_ID—The ID for the scheduled task that ran (if applicable).

* PARENT_ID—The task ID of the previous task that started the listed task (if applicable).

* THREAD_NAME—The name of the thread used by the task.

* CLIENT_NAME—The host name of the printer or software client that submitted the job (if applicable).

* PRINTER_MODEL—The printer model number reported by the printer that submitted the job (if applicable).
* JOB_TYPE—The device class for which the task runs a profile (if applicable).

* HAS_SCANNER—The Boolean value (0 or 1) for identifying whether the printer that submitted the job has

a scanner.

Using included subreports

Some subreports included may be useful in developing other custom reports. Since these files are included
with the installation, they do not have to be uploaded before adding a form that includes any of them.

When using a subreportin a custom report, you must pass the start date,end date,and SUBREPORT DIR
to the subreport using the Parameters property of the subreport element.

File name Page Description

orientation
_portrait_title jasper Portrait Displays a default header image, the title of the report, and

the selected reporting period for use as a headerin a report
_landscape_title jasper Landscape P 9p P
_portrait_footer.jasper Portrait Displays the date when the report was created, and the
] page number for use as a footer in the report

_landscape_footer.jasper Landscape
_portrait_no_data_message.jasper Portrait Displays a message indicating that no data was found

_landscape_no_data_message.jasper

Landscape

within the selected period for use as a No Data node in a
report

Note: By default, iReport does not generate a report if
there is no data. To use a No Data node, change the
setting for when there is no data in the report from No
Pages selection to No Data Section.

_Printers_Least_Used Either Displays the printers least used to submit jobs
_Printer_Models_Most_Used Either Displays the printer models most used to submit jobs
_Printers_Most_Used Either Displays the printers most used to submit jobs
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File name Page Description

orientation

_Server_Stats Either Displays a breakdown of job types run on a server

Note: This subreport uses the additional parameter
SERVER, which contains the host name of the server for
which the subreport should be run.

_Servers_Most_Used Either Displays the servers that have processed the most jobs
_SoftwareClients_Most_Used Either Displays the software clients most used to submit jobs
_Solution_Profile_Most_Used Either Displays the solution profiles most used for submitted jobs
_Solution_Profile_Printers Either Displays the printers from where the most jobs are

submitted for each profile

_Solution_Profile_Scheduled_Scripts | Either Displays the solution profiles most often run by scheduled
tasks

_Solution_Profile_SoftwareClients Either Displays the software clients from where the most jobs are
submitted for each profiles

_Solution_Profile_Users Either Displays the users who most often submit jobs for each
profile

_Solutions_Most_Used Either Displays the solutions most used for submitted jobs

_Task_Most_Run Either Displays the most frequently run tasks

_Users_Most_Active Either Displays the users who have submitted the most jobs

_Users_Most_Cancellations Either Displays the users who have canceled the most jobs

_Users_Printers Either Displays the users who most often submit jobs for each
printer

_Users_SoftwareClients Either Displays the users who most often submit jobs from each

software client
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Backup and disaster recovery

Note: The database backup and recovery tasks apply only to Firebird. If you are using Microsoft SQL, then
contact your database administrator.

Scheduling automatic backups

You can back up the databases and solutions in an LDD system to a network share. In the event a recovery is
necessary, a new system can access the recovery data using Restore Install. You can direct existing servers
from a partially failed system to the new load balancer and/or database, or you can install new servers.

When a scheduled backup occurs, the system validates backup database files on the share and sends an
e-mail message that indicates success or failure to the address specified for the “Admin email address” setting
of the Confirm service. Any failures are also recorded in the system log.

Note: Backups should be scheduled during off-peak times to avoid negatively affecting system performance.
1 Click the System tab.

Select Schedule from the System list.

Click Add > Backup Restore.

Type a description for the task, and then click Next.

ga A W N

Type the UNC path of the existing network share (for example, \\myserver\myshare\)where the system
should be backed up.

Note: When storing backup data from multiple LDD systems, make sure to assign a different folder to
each LDD system. Assigning a backup folder for each LDD system prevents an existing data from being
overwritten by another system. This also helps you identify from which LDD system the backup data
belongs to.

6 If the network share requires authentication, then type the user name and password.
7 To back up the jobs list and the log, make sure the Backup Jobs Logs Database check box is selected.

8 To keep previous backup sets, make sure the Keep previous backups check box is selected. If this option
is selected, data from each backup is stored in a folder named with the date of the backup within the
specified network share folder. If it is cleared, backup data is stored directly in the specified network share
folder, overwriting any previous data.

Note: The database containing the jobs list and the log may be very large. If both Backup Jobs Logs
Database and Keep previous backups check boxes are selected, regularly make sure that you have
enough space on the network share where the files are backed up.

9 Click Next.
10 Enter a start date and a start time.
11 Configure the frequency of the scheduled event, and then click Finish.

Note: When keeping previous backups, you can delete dated backup folders containing entire previous
backups as necessary, but do not modify the internal folder structure of backup data.



Monitoring and maintaining the system 76

Recovering backup data with a new installation

When a recovery is necessary and you are using a network share backup, a new load balancer or database
and load balancer together can access backup data using Restore Install.

Note: If only the load balancer has failed, then you can restore the load balancer by itself. However, if only
the database has failed, then you must restore the database, and then restore the load balancer as well.

1 Select the appropriate installation, proceeding to the final step of the installation wizard without clicking
Finish:
* |f a workgroup system has failed, then perform a workgroup installation.

® [fthe database and load balancer together or the database only has failed in an enterprise system, then
install the database.

® |f only the load balancer has failed in an enterprise system, then install the load balancer.
2 Select Restore Install (RI).

3 Type the path of the folder containing the .ri file from the backup data.
or
Click the folder icon and then locate the .ri file from the backup data.

4 Click Finish to complete Restore Install.

5 If you are using an enterprise system and you just installed the database, then repeat steps 1through 4 for
the load balancer.

6 If you are using an enterprise system, then add servers to the system and set them online.
* |f you are installing new servers, then see “Installing hew servers during recovery” on page 76.

® [f you are using existing servers, then see “Connecting existing servers during recovery” on page 77.

7 If the new load balancer is identified by a new IP address or fully qualified domain name, then do the
following:

a Recreate any LDD printer ports on software clients. For more information, see “Recreating LDD printer
ports after an address change” on page 78.

b Change settings for any associated eSF applications that specify the load balancer address using the
eSF Configuration task on the Device Groups tab in LMC. For more information, see “Configuring an eSF
application associated with a solution” on page 82.

Installing new servers during recovery

1 On computers where you want to install servers, make sure the time is synchronized with existing system
components using an NTP server.

2 Perform server installations using the new database and/or load balancer. For more information, see
“Installing servers” on page 32.

3 Install any third-party services required by installed solutions on each new server.
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4 Perform policy updates as necessary:

* [fthe new database and load balancer are identified by the same IP address(es) and fully qualified domain
name(s) as the failed database and/or load balancer, then perform a policy update for any device groups
that contain e-Task printers, making sure to clear the Only update those devices which are Out of
Policy check box.

® [fthe backup database or load balancer is identified by a new IP address or fully qualified domain name,
then perform a policy update for all device groups, making sure to clear the Only update those devices
which are Out of Policy check box.

5 From the System tab in LMC, set the new servers online. For more information, see “Viewing and changing
server status” on page 52.

6 If new servers are identified by different addresses than the failed servers, then the failed servers remain
in the system and appear as hon-communicating on the System Status page. To avoid affecting system
performance, remove these servers from the System tab in LMC.

Connecting existing servers during recovery

Do the following after the database or load balancer is recovered:

* |f the new database and load balancer are identified by the same IP address(es) and fully qualified domain
name(s) as the failed database and/or load balancer, then do the following:

1 Make sure the time is synchronized among all system components using an NTP server.

2 Restart the Lexmark Solutions Application Server service from the Windows Services control panel on
each server.

3 Perform a policy update for any device groups that contain e-Task printers, making sure to clear the
Only update those devices which are Out of Policy check box.

4 From the System tab in LMC, set the servers online. For more information, see “Viewing and changing
server status” on page 52.

* |f the new database or load balancer is identified by a new IP address or fully qualified domain name, then
do the following on each server:

1 Make sure the time is synchronized among all system components using an NTP server.
2 From the Services control panel, stop the Lexmark Solutions Application Server service.

3 In the file \Lexmark\Solutions\apps\wf-ldss\WEB-INF\classes\adaptor.properties where the server is
installed, change each of the properties adaptor.address and adaptor.canonicalhostname to
the IP address or fully qualified domain name of the new load balancer.

Note: If the setting is currently an IP address, then use the IP address of the load balancer. Likewise,
if the setting is currently a fully qualified domain name, then use the fully qualified domain name of
the load balancer.
4 Change the URL for the desktop shortcut to LMC on the server:
a Inthe folder \Lexmark\Solutions\apps\wf-Idss\, right click the shortcut Imc, and then click Properties.
b Change the IP address or host name part of the URL to the new IP address or host name of the new
load balancer. The complete URL should be http://hostname:9780/1lmc/, where hostname is
the host name or IP address of the new load balancer.



Monitoring and maintaining the system 78

5 If you are using a new database, then locate the file
\Lexmark\Solutions\apps\wf-ldss\WEB-INF\classes\database.properties where the server is installed,
and then change the property database.hostname to the fully qualified domain name of the new
database.

Note: If you are using an IP address for this setting because the network does not have a reliable
DNS, then you can use the IP address of the new database.
6 From the Services control panel, start the Lexmark Solutions Application Server service.

7 Perform a policy update for all device groups, making sure to clear the Only update those devices which
are Out of Policy check box.

8 From the System tab in LMC, set the servers online. For more information, see “Viewing and changing
server status” on page 52.

Recreating LDD printer ports after an address change

If the new load balancer is identified by a new IP address or fully qualified domain name after a recovery, then
you must recreate any LDD printer ports on software clients.

1 In the printers control panel in Windows, right-click an LDD print queue, and then click Properties.

Note: For more information about accessing the properties for the Lexmark Document Server port, see
“Configuring a Lexmark Document Server port” on page 105.

2 Click the Ports tab > Add Port > Lexmark Document Server Port - Enterprise > New Port.
Note: The port name must be 75 characters or fewer.

3 Add the new Lexmark Document Server:

Click Manage List.

From the Server Setup dialog, click Add.

Type the fully qualified domain name or IP address of the load balancer, and then click OK.

Select the old load balancer from the list, then click Remove, and then click Yes to confirm removal.
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Click OK to exit the Server Setup dialog.

4 Make sure the new server is selected from the Document Server list, and then click Next.

()

Select a profile on the server to use with the new port, and then click Next.

Note: If the server is currently running a large number of jobs, then profiles on the server may not appear
in the list. Wait until the server is not as busy, and then try adding the port again.

Click Finish to add the new port.
If you are using pooled ports, then add additional ports using the same server and profile.

If the Printer Ports dialog is still open, then click Close.

O 0 N O

Make sure only newly created ports are selected, and then click Apply.

10 Do the following for each port associated with the failed load balancer:
a Select the port from the list.

b Click Delete, and then click Yes to confirm deletion.

Note: If a port cannot be deleted, then it may still be associated with the print queue. Make sure only
newly created ports are selected, then click Apply, and then try again.
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11 If necessary, select newly created ports again.

12 Click Close.

Manually backing up databases

You can back up the LDD databases using any normal Firebird backup procedure. For manual backups, you
can use GBAK. exe, located in the \Lexmark\Solutions\firebird\bin\ folder within the folder where the LDD load
balancer or database is installed.

The following databases, located in the \Lexmark\Solutions\firebird\data\ folder within the folder where the LDD
database is installed, should be included in the backup:

* EFORMS.FDB

* FRAMEWORK.FDB

* |LICENSE.FDB

* MONITOR.FDB

* QUARTZ.FDB

®* SOLUTIONINFO.FDB

The user name for each database is framework, and the password is rivet.
The following command is recommended for each file:

LDD folder\firebird\bin\gbak.exe -v -t -user framework -password rivet
"DB IP address:LDD folder\firebird\data\source db" "backup db"
Make the following replacements:

® LDD folder—Thisisthe folder where the LDD database is installed. This folder typically starts with a prefix
C:\Program Files\Lexmark\Solutions\.

® DB IP address—This is the IP address of the LDD database.
® source db—This is the file name of the database file to back up.
® backup db—This is the path and file name of the backup database file, which uses the extension .fbk.
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Managing solutions and cSF apps

Understanding the deployment process

1 Set servers offline to prevent execution of profiles before configuration is complete. For more information,
see “Viewing and changing server status” on page 52.

2 Upload the solution or cSF app to the system and adjust global settings for the solution.

3 Create a device group to contain printers where the solution or cSF app will be deployed.

Note: Multifunction and single-function printers are known as devices in LMC.
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Create discovery profiles to add printers to the device group.

Discover printers in the device group according to the discovery profiles.

Update the device policies for the printers in the device group.

Add the solution or cSF app to the device group and adjust local settings, if necessary.

Configure home screens for the device group to use the deployed solution or cSF app.

Set servers online. For more information, see “Viewing and changing server status” on page 52.

Each step is covered in more detail in the following sections.

Note: Some solutions or cSF apps may automatically complete any or all of steps 3 through 8 if the creator of
the solution or cSF apps included auto-configure. For more information, see the documentation associated
with a specific solution.

Understanding solution or cSF app settings

Setting  Location in LMC Initial configuration
type Solution
Global Configuration task on 1 Click the ¢SF App | After uploading the All printers in all device
the Solutions tab tab. solution in LMC groups to which the
2 Click the checkbox solution is applied, or all
by every cSF app. software clients in all
) software client groups to
3 Cllck.Config which the solution is
Service, and then applied
click Yes.
Local Solutions task on the N/A During deployment to | All printers in the selected
Device Groups or a device group or device group, or all
Software Client Groups assignmentto a software clients in the
tab (Select a solution, software client group | selected software client
and then click Edit.) group
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Uploading solutions to the LDD system

1 Click the Solutions tab.
2 Select All Solutions from the Solutions list.

3 Click Install/Upgrade.

4 |n the window that appears, type a path to a solution file, or click Browse to browse to the solution file.

5 Click Upload.

Notes:

* |f you are upgrading an existing solution, then it is recommended that you set all servers offline so that
jobs for the solution are not accepted during the upgrade. Servers can be set online again after policy
updates for the associated device groups. For more information, see“Viewing and changing server
status” on page 52.

® |f you install a workflow solution that includes a component, then you may need to restart the Lexmark
Solutions Application Server from the Windows Services control panel for the solution to fully function.

® Solutions should be removed from home screens, device groups, and software client groups before
removal. For more information about removing solutions, see “Removing solutions or cSF apps” on

page 83.
® You can upload a solution to the LDD system directly from Eclipse by adding the solution to the LDD 4.x
System List. For more information, see the Lexmark Document Distributor SDK Guide.

Configuring global settings

Configuring global solution settings

1 Click the Solutions tab.
2 Select a solution name from the list.
3 Select Configuration from the Tasks list.

4 Adjust the settings for the solution as needed. For more information, see the documentation that came with
the solution.
Note: When updating the shortcut number of a profile, make sure to match it with the shortcut number in
the Home Screen settings. For more information on configuring the home screen, see “Customizing the
home screen for a device group” on page 90.

5 Click Apply.

Configuring global cSF app settings

1 Click the cSF Apps tab.
2 Select All cSF Apps, and then check the checkbox next to the cSF app that you want to configure.
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3 Click Config Service, and then click Yes.
4 Adjust the settings for the cSF app as needed.

Note: When updating the shortcut number of a profile, make sure to match it with the shortcut number in
the Home Screen settings. For more information on configuring the home screen, see “Customizing the
home screen for a device group” on page 90.

Editing local settings for a deployed or assigned solution

Local settings are configured during deployment or assignment of a solution.

1 Select a group:
a Click the Device Groups tab.

b Select a device group from the Device Groups list.

or
a Click the Software Client Groups tab.

b Select a software client group from the Software Client Groups list.
2 Select Solutions from the Tasks list.
3 Select a solution from the list in the main section, and then click Edit.
4 Configure the deployment settings of the solution for the current device group, and then click Finish.

Note: A policy update is required after changing settings that affect a device group. For more information
see “Updating policies for device groups” on page 94.

Configuring an eSF application associated with a solution

If a hybrid solution is installed, and an associated eSF application includes a descriptor file, then you can edit
the eSF application settings for e-Task 2+, e-Task 3 and e-Task 4 printers. Each device group contains separate
settings for any eSF applications, much like local solution settings.

Note: LDD can only manage eSF application settings for e-Task 2+, e-Task 3 and e-Task 4 printers. You must
configure eSF application settings for e-Task 2 and X642 printers using the Embedded Web Server on each

printer after the application is deployed.

1 Click the Device Groups tab.

2 Select a device group from the Device Groups list.

3 Select eSF Configuration from the Tasks list.

4 Seclect an eSF application from the list in the main section.

5 Select the Verify eSF application deployment and deploy these eSF settings check box.
6 Select an e-Task printer in the Deploy to section.

Note: If you are configuring advancedprompt, then make sure to select ALL to install Advanced
Prompting Bundle in all printers running the LDD solution.

7 Configure the settings of the eSF application for the current device group, and then click Save Settings.
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Note: A policy update is required after changing eSF application settings for a device group. For more
information see “Updating policies for device groups” on page 94.

Managing solution-related files

Some solutions may include properties files or other associated files.

Files associated with only a single solution are located in the \Lexmark\Solutions\apps\wf-
Idss\solutions\SolutionName\WEB-INF folder where each server is installed. SolutionName is the name of the
solution.

Files added by a solution to be shared with all solutions are located in the \Lexmark\Solutions\apps\wf-ldss\
folder where each server is installed.

For more information, contact the developer of your solution.

Note: If you restart the Lexmark Solutions Application Server service, then any solution-related file is
reverted to the version stored with the solution package as it was initially installed or upgraded, and any
manual changes are lost.

Removing solutions or cSF apps

1 Remove home screen buttons for the solution on any printers where they appear:
a Click the Device Groups tab.

b Select a device group where a home screen button is assigned to the solution or cSF app from the
Device Groups list.

¢ Select Home Screen from the Tasks list.

d Do the following for each device class that includes a button assigned to the solution or cSF app:
1 Select the button.
2 Select None or a different action from the Action list.
3 Click Apply.

e Repeat these steps for any other device groups that contain a home screen button assigned to the
solution or cSF app.

2 Deletethe solution or cSF app from any device groups or software client groups where it has been deployed:
Click the Device Groups tab.

Select a device group where the solution has been deployed from the Device Groups list.

Select Solutions or ¢SF Apps from the Tasks list.

Select the solution or cSF app from the list.

Click Delete.

Repeat these steps for any other device groups where the solution or cSF app has been deployed.
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3 Remove the solution or cSF app from the system:
a Click the Solutions or cSF Apps tab.
b Select All Solutions or All cSF Appsfrom the list.
Cc Select the solution from the Summary list.

d Click Remove.
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If a solution has associated forms, then you are asked whether to remove the associated forms along
with the solution.

Notes:

® Forms may be shared among solutions, and removing forms that are used by any remaining
solutions will stop those solutions from working correctly.

®* Removing a solution automatically removes any associated scheduled tasks.
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Managing device groups and devices

Creating and populating device groups

Understanding device groups

A device group is a collection of printers that share one or more solution deployments with the same local
configuration. At least one device group must be created to deploy solutions. Multiple device groups should
be created if either more than one solution is deployed to different sets of printers or one solution is deployed
with different local configurations for different printers.

Note: Printers are known as devices in LMC.

Printers can be members of more than one device group. Solutions from each device group to which a printer
belongs will be deployed to that printer.

Solution 1
* solution file

-Seripts
~Policy
o Welcome Screen Layout
o Device Settings
o Solution Settings
© Local
© Global
-eSF
-3rd party jar files
-Status Page

Solution 2
solution file

-Scripts
Policy
© Welcome Screen Layout
« Device Settings
« Solution Settings
© Local
0 Global
-eSF
-3rd party jar files
_Status Page

Solution 1
Configuration A &

. Solution 2
Solution 1 @ B

Configuration A

Solution 2 Solution 1 Configuration C
Confi, B &

Solution 2 Configuration D

Creating a device group
1 Click the Device Groups tab.
2 Under the Device Groups list, click the Add button.

3 Type a unique name for the device group, and then click Add.
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Creating a device group from an existing device group
1 Click the Device Groups tab.

2 Under the Device Groups list, click Add.

3 Type a unique name for the new device group.

4 Select the existing group to copy, and then click Add.

The following settings are copied from the existing device group to the new device group:
® Solution associations
® Solution settings
® eSF application associations
® eSF application settings
® Home screen configurations
® Fax forwarding configurations
® Security settings

Configuring policy updates
1 Click the Services tab.
2 Select PolicyUpdate from the Services list.
3 If necessary, select Parameters from the Tasks list.
4

Type a timeout period in seconds for each device during a policy update.

The timeout setting for the PolicyUpdate service determines how long the system waits for a printer to
respond after it is initially connected during a policy update.

Note: If a large eSF application or several eSF applications are included with a hybrid solution, then you
may need to increase the default timeout for policy updates in order to allow enough time for policy
updates that include eSF application deployments to complete.

5 Select the Overwrite all function overrides on the device check box.

Note: If there are eSF applications installed on the device that can override the device function, then
clear the Overwrite all function overrides on the device check box. Otherwise, this setting should be
selected at all times.

6 Click Apply.

Creating a new discovery profile

1 Click the Device Groups tab.

2 Select a device group from the Device Groups list.
3 Select Discovery Profiles from the Tasks list.

4 Type the IP address, address range, subnet, host name, or fully qualified domain name in the Address field.
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Address format Example

IP address 10.10.2.100

IP address range 10.10.2.1-10.10.2.127

Subnet 10.10.2.*

Host name printer-host-name

Fully qualified domain name | printer-host-name.domain-name

5 Type information in the remaining fields for any optional filters.

6 Click Add in the main section to save the discovery profile.

Importing a list of printers to a device group

A list of printers can be imported from an XML, TXT, or CSV file exported from MarkVision or other systems.
1 Click the Device Groups tab

Select a device group from the Device Groups list.

Select Discovery Profiles from the Tasks list.

Click Import.

Type the path of the file, or click Browse, and then locate the file.
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Click Upload.

The entries in the file are added to the list of discovery profiles. Perform a device discovery to search for
the imported printers.

In a TXT file, each line contains the host name or IP address for a single printer.

In a CSV file, each line contains the record for a single printer. Each line may contain a single IP address or fully
qualified domain name, or the following fields may be used:

IP address or fully qualified domain name, SNMP read name, SNMP write name,
device class, device model, serial number, contact name, contact location,
property tag

As with any CSV file, you must still include a comma for a blank field followed by populated fields.

An XML file is structured like the following example:

<?xml version="1.0" encoding="UTF-8" ?>
<filterss
<filters
<addressRange>10.10.2.200</addressRange>
<snmpRead>public</snmpRead>
<snmpWrites>public</snmpWrites>
<contactName>John Doe</contactNames>
<contactLocation>Office 1A</contactLocations
<serialNumber>0123456789</serialNumbers>
<propertyTag>XYZ123</propertyTag>
<deviceClass>All</deviceClass>
</filter>
<filters>
<addressRange>10.10.2.150</addressRange>
<snmpRead>public</snmpRead>
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<snmpWrite>public</snmpWrites>
<contactName>Don Joseph</contactNames>
<contactLocation>0ffice 2B</contactLocation>
<serialNumber>1234567890</serialNumbers>
<propertyTag>ABC789</propertyTag>
<deviceClass>All</deviceClass>

</filter>

</filterss>

Discovering printers

Before a solution can be deployed to a printer, the printer must be discovered as part of a device group. Printers
may be manually discovered or automatically discovered on a schedule. This section covers manual discovery,
which is used during initial setup of the system. For more information about scheduled discovery, see
“Scheduling a discovery task” on page 89.

1
2
3

Click the Device Groups tab.
If necessary, create a new discovery profile.

Select a device group from the Device Groups list, or select All Device Groups to discover printers in multiple
device groups.

4 Select Discovery from the Tasks list.

If you are discovering printers in a device group or groups where you have previously discovered printers,
and you want to skip any IP address where a printer has been discovered (including currently missing
devices), then select Discover new devices only. This results in a faster discovery when adding subsequent
discovery profiles.

If you are discovering printers from multiple device groups, then select the device groups for the discovery
task in the main section. The list does not appear if a specific device group is selected in the Device Groups
list.

If necessary, click Edit to edit the discovery configuration.

Note: For more information about adjusting timeout periods for device discovery, see “Configuring NPA
device communication” on page 61.

Click Discover.
After device discovery, the system reports the number of printers discovered. To see the discovered
printers, select the Discovered Devices task.
Notes:
® |f you stop the discovery process, then it may take a few minutes for the discovery task to completely
stop.

® After a printer has been discovered, removing the related device group or discovery profile does not
remove the printer from the system. For information about removing printers from the system, see
“Removing devices from the system” on page 98.

® After the discovery process, the number of missing devices appears, if applicable. Click Missing
Devices Count to launch the Missing Devices task. For more information, see “Discovering missing
printers” on page 89.
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Discovering missing printers
If a printer is offline during a discovery, then it will be identified as missing.
1 Click the Device Groups tab.

2 Select a device group from the Device Groups list, or select All Device Groups to discover missing printers
in multiple device groups.

3 Select Missing Devices from the Tasks list.

4 If you are discovering missing printers in multiple device groups, then select the device groups for the
discovery task in the main section. The list does not appear if a specific device group is selected in the
Device Groups list.

5 If necessary, edit the discovery parameters.

6 Click Discover.

Viewing all printers with outdated policies
1 Click the Device Groups tab.
2 Select All Device Groups from the Device Groups list.

3 Select Out of Policy Devices from the Tasks list.

Scheduling a discovery task
1 Click the Device Groups tab.

2 Selectadevice group fromthe Device Groups list, or select All Device Groups to discover devices in multiple
device groups.

Note: Make sure discovery profiles exist for device groups to be included in the operation.

3 Select Schedule from the Tasks list.

4 Click Add > Discovery.

5 Type a description for the task, and then click Next.

6 |If you are discovering devices from multiple device groups, then select the device groups for the discovery
task, and then click Next. The list does not appear if a specific device group is selected in the Device Groups
list.

7 Enter a start date and a start time.

8 Configure the frequency of the scheduled event, and then click Finish.

Deploying solutions to a device group

Deploying a solution to a device group creates profiles on the printers in the group that allow users to execute
jobs using the solution.
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Note: It is recommended to set servers offline before deploying solutions to device groups to prevent
execution of associated profiles before you have completed configuration. For more information, see
“Viewing and changing server status” on page 52.

1 Click the Device Groups tab.

2 Select a device group from the Device Groups list.

3 Select Solutions from the Tasks list.

4 In the main section, click Add.

5 Select the solution from the list, and then click Next.

6 Configure the deployment settings of the solution for the current device group, and then click Finish.

Note: A policy update is required to complete the deployment of the solution. For more information see
“Updating policies for device groups” on page 94.

Customizing the home screen for a device group

You can configure printers in a device group so that buttons for deployed solutions appear on printer home
screens (or in the menus of non-touch-screen printers). A custom home screen is not a requirement to deploy
a solution. However, if the default home screen is used, then solutions must be accessed through the Held
Jobs menu on the printer.

Because different device classes have different capabilities, a separate custom home screen must be
configured for each device class.

Notes:

® On e-Task 2+ and e-Task 3 printers, actions included in a custom home screen must be enabled in the
printer settings to appear on the home screen. To adjust these settings, type the printer IP address on
your Web browser to access the printer Embedded Web Server, and then click Settings > General
Settings > Home screen customization. For a list of e-Task 2+ and e-Task 3 printers, see “Supported
printers” on page 14.

® |n printers assigned to more than one device group with a custom home screen, the last policy update
determines which home screen is used. If multiple device group membership is necessary, then do not
configure a home screen for more than one of the device groups to which the printer belongs.

1 Click the Device Groups tab.

2 Select a device group from the Device Groups list.

3 Select Home Screen from the Tasks list.

4 Click the tab for the class of printers that you want to configure.

5 Select Use this home screen as part of the device group's policy .

6 Configure a button on the home screen:
® For touch screen printers:
a Select the number of buttons to include from the Layout menu.
b If necessary, click a page, and then click the button to configure.
c Select an action for the button:
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Notes:

— Make sure to select an action for all the buttons that you want to appear on the home screen.

— If you have customized the home screen in your previous sessions, then reset the actions of
the buttons on all pages before applying the new settings. Standard functions such as copy,
fax, and e-mail do not automatically appear on the home screen. You need to assign an action
for these functions to appear on the home screen.

Functions Available selections!

Execute a standard MFP function — Change Language
— Copy

— Copy Shortcuts

— Fax

— Fax Shortcuts

— Email

— Email Shortcuts

- FTP

— FTP Shortcuts

— Search Held Jobs
— Held Jobs

— Release Held Faxes
— Held Faxes

— USB Drive

— Bookmarks

— Jobs by user

— Lock Device

— Printer Panel

Show a list of profiles Profiles

Execute a specific profile Single Profile

Override a standard function with a profile? Copy + Profile
Fax + Profile
Email + Profile

FTP + Profile

Execute a printer shortcut Shortcut

" Not all selections are available for all models.

2 A standard function overrides itself when configured with a profile. For example, Copy + Profile executes
the same function as Copy.

3 LMC cannot access eSF application icons directly. Use placeholders to provide locations for eSF
application icons in the default order. Use App Reservation to designate a location for the icon of an eSF
application identified by name, and then set the profile name of the application. For example, the profile
name for the Scan to Network application is senToNet. If no placeholders or App Reservations are
provided, then any installed eSF applications appear on the first page after the pages defined in the
custom home screen.
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Functions Available selections!

Provide a placeholder for an eSF application | — App Reservation
icon3

icon — Placeholder
Leave a blank space none

" Not all selections are available for all models.

2 A standard function overrides itself when configured with a profile. For example, Copy + Profile executes
the same function as Copy.

3 LMC cannot access eSF application icons directly. Use placeholders to provide locations for eSF
application icons in the default order. Use App Reservation to designate a location for the icon of an eSF
application identified by name, and then set the profile name of the application. For example, the profile
name for the Scan to Network application is senToNet. If no placeholders or App Reservations are
provided, then any installed eSF applications appear on the first page after the pages defined in the
custom home screen.

d If necessary, specify the details of the action:
— If you selected Shortcut, then enter the number of the shortcut.

[ Use this home screen as part of the device group's palicy.

Page 2 Page 3 Paged
Layout: | 1 Button 2]

Choose each button and set its action. Buttons with no actions will not appear on the
Home Screen.

Action: Sharteut B

Display ~ ® Default

Text: ® /7

Shortcut 1 Graphic: ‘ Default |

‘D ‘ Custom... |

Shartout:™® [1

‘ Apply | Reset

Notes:
® Shortcuts added in the LMC refer to device-class shortcuts, and not eSF
application-specific shortcuts.

® When updating the shortcut number of a profile in the Solution settings, make sure to
match it with the shortcut number in the Home Screen settings.

— Ifyou selected Single Profile or if you are overriding a standard function with a profile, then select
a profile.
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— If you selected App Reservation, then type the profile name of the eSF application that uses the
button.

= Use this home screen as part of the device group's policy.
Page 1| Page 2 Page 3 Page 4

Layaut: | 1 Button 2]

Choose each button and set its action. Buttons with no actions will not appear on the
Home Screen.

action: | App Reservation | 2|

Profile:*

—

Lpaly Reset

e The graphic that appears on the button is the default graphic of the action. If you want to select a
custom graphic for any action except Placeholder or App Reservation, then do the following:
1 Click Custom.

2 Click Change, and then select a JPEG, GIF, or PNG file for the Up and Down icons.
3 Click Apply.

Note: If you want to revert to the default graphic, then click Default.
Images selected are resized to the following dimensions for each device class. For best results, resize
or crop source images to the correct size before use.
— e-Task—120 x 80 pixels
— e-Task 2, e-Task 2+, and SFP e-Task 2+—120 x 75 pixels
— e-Task 3—172 x 254 pixels
— e-Task 4—172 x 254 pixels
— X642—120 x 55 pixels

Note: For a list of supported printers in each device class, see “Supported printers” on page 14.

f To apply custom text to any button except a Placeholder or App Reservation, select the Text option,
and then type your custom text. You can also select the Text option and leave it blank to display only
the icon.

® For non-touch-screen printers:
a Select Custom from the Layout menu.
b Click Add below the list of buttons.

Notes:

— The only action available is Single Profile. You cannot modify other menu items on a printer
without a touch screen.

— Toremove a button, select it in the list, and then click Remove.

¢ To apply custom text to the button, select the option for the custom text field beside Display Text,
and then type your custom text.

d Select a profile to associate with the button.
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7 Configure the rest of the buttons on the home screen.

8 Apply the changes.

Note: Before changing tabs during configuration, make sure to click Apply on each tab to apply the
settings.

Updating policies for device groups

When solutions are deployed, home screens are configured, or settings are changed for a device group, the
printers in the group are marked as “Out of Policy,” and a policy update is required to apply the changes to the
printers. Changes are not automatically pushed to printers, so you can schedule policy updates during times
of off-peak usage to avoid negatively affecting system performance.

Additionally, because the system cannot monitor changes that occur outside of the system that affect the policy
conformance of a printer, it is a good idea to schedule policy updates after a system is set up. For more
information, see “Scheduling policy updates” on page 95.

Policy updates include deployment of eSF applications to e-Task 2 printers when necessary. This includes
deployment of the Advanced Prompting Bundle the first time policies are updated on e-Task 2 printers,
first-time deployment of eSF applications associated with hybrid solutions, and any policy updates immediately
after the Advanced Prompting Bundle or other eSF applications are updated. Validation that occurs during
deployment of eSF applications causes policy updates that include eSF deployments to take significantly longer
than those that do not.

If a large eSF application or several eSF applications are included with a hybrid solution, then you may need
to increase the default timeout for policy updates using the PolicyUpdate service on the Services tab in order
to allow enough time for the policy update to complete. If you do not want to validate eSF application
deployment on each printer, then see “Disabling validation of eSF application deployment” on page 95.

1 Click the Device Groups tab.

2 Selectadevice group from the Device Groups list, or select All Device Groups to update policies for printers
in multiple device groups.

3 Select Policy Update from the Tasks list.

Note: The Policy Update task can also be accessed from the Policy Update link in the reminder shown
when working with the Solutions and Home Screen tasks.

4 Select the update method:
® To update only out-of-policy printers, select the Only update those devices which are Out Of Policy
check box.
® To update all printers, regardless of current policy conformance, clear the Only update those devices
which are Out Of Policy check box.

5 If you are updating policies for printers in multiple device groups, then select the device groups for the
policy update task in the main section. The list does not appear if a specific device group is selected in the
Device Groups list.

6 Click Update Policy to deploy the solutions to the printers in the device group.

Note: After updating policies, the Policy Update status appears showing the number of devices that
failed to update, if applicable. Click Failed Devices Count to view the error logs for this task. To view the
full set of logs for this task, clear the Message filter.
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Scheduling policy updates

1 Click the Device Groups tab.

N

Select a device group from the Device Groups list, or select All Device Groups to update policies for printers
in multiple device groups.

Select Schedule from the Tasks list.
Click Add > Policy Update.
Type a description for the task, and then click Next.

o Ul A W

If you are updating policies for printers in multiple device groups, then select the device groups for the
policy update task in the main section. The list does not appear if a specific device group is selected in the
Device Groups list.

N

Enter a start date and a start time.

8 Configure the frequency of the scheduled event, and then click Finish.

Enabling secure communication between servers and
printers in a device group

Note: Secure communication between printers and servers is required when using a solution with Kerberos
authentication.

1 Click the Device Groups tab.
2 Select a device group from the Device Groups list.
3 Select Security from the Tasks list.

4 Enable secure communication, and then click Apply:

® To secure only the credentials such as user name and password of the session, select the Enabled for
Credentials option.
This option is faster than a communication that is set to “Enabled for Session.”

® To completely secure the session, select the Enabled for Session option.

Disabling validation of eSF application deployment

Validation that occurs during deployment of eSF applications causes policy updates that include eSF
deployments to take significantly longer than those that do not. If you do not want to validate eSF application
deployment on each printer, then do the following:

Note: eSF settings configured using the eSF configuration task are not deployed when validation of eSF
application deployment is disabled.

1 Click the Device Groups tab.
2 Select an appropriate device group from the list.

3 Select the eSF Configuration task.
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4 Clear the Verify eSF application deployment and deploy these eSF settings check box, and then click
Save Settings.

5 Repeat steps 2 through 4 for any other appropriate device groups.

Using the Devices tab

The Devices tab is generally used for specialized maintenance and troubleshooting, rather than the setup and
ordinary maintenance that are managed through device groups.

Searching for devices
Before performing device-specific tasks, previously discovered devices must be selected by searching for
matching values of certain criteria, selected from the following:
® Address
® Hostname
® Device Model
® Serial Number
® Contact Name
® Contact Location
® Property Tag
Click the Devices tab.
Select a search criterion.

Enter a value to search.

H W N o

Click Search.

Note: Using the asterisk wildcard character (*) to represent the sections at the end of the IP address will
return all devices in that subnet. For example, type 10.10. *. * to find all devices that have been discovered
within the range 10.10.0.1-10.10.255.255. Also, a range of IP addresses can be used as a search criterion by
entering the first and last addresses, separated by a hyphen.

Editing the home screen layout on specific devices

The Home Screen task on the Devices tab accesses the home screen and available profiles of selected printers
directly, unlike the corresponding task on the Device Groups tab, which lets you configure a common home
screen to be deployed during a policy update and only provides access to LDD profiles.

Accessing the home screen configuration for specific devices may be helpful for the following tasks:
® Troubleshooting home screen issues on specific devices
® Configuring home screens on specific devices for which custom home screens are not configured within a
device group
® Configuring home screens that include non-LDD profiles
® Removing orphan buttons from the home screen
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Notes:

® |f a custom home screen is configured for a device group that contains the printer, then any changes
made will be overwritten during the next policy update.

® LMC cannot access eSF application icons directly. Use placeholders to provide locations for eSF
application icons in the default order, and then use App Reservation to designate a location for the icon
of a specific eSF application identified by name. If no placeholders or App Reservations are provided,
then any installed eSF applications appear on the first page after the pages defined in the custom home

screen.
Click the Devices tab.

Search for printers.

Select device names in the Devices list.

Select Home Screen from the Tasks list.

g H W N a

To edit an individual home screen, click Edit.

Make any necessary changes to the layout of the home screen, and then click Apply. To cancel editing,
click Reset.

6 If multiple devices are selected, click Next to view the home screen of the next device on the list.

Viewing device profiles

1 Click the Devices tab.

2 Search for device(s).

3 Select the device name(s) in the Devices list.

4 Select Profiles from the Tasks list.

5 Select a profile name from the list to view the profile settings.

6 If multiple devices are selected, then click Next to view the next device on the list.

Updating device policies

1 Click the Devices tab.

2 Search for the device or devices.

3 Select the device names in the Devices list.
4 Select Policy Update from the Tasks list.

5 Click Update Policy.

Note: After policies are updated, the Policy Update status appears and shows the number of devices
that failed to update, if applicable. Click Failed Devices Count to view the logs, and then select the task

ID in the Jobs page to view the details.
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Removing devices from the system

1 Click the Devices tab.
2 Search for one or more devices.

3 Select one or more device names in the Devices list.

4 Click Remove from System > Yes.

Notes:

® Removing a device from the system does not remove profiles that have been deployed to the device,
reverse any home screen modifications, or remove eSF applications installed with any solution.

® |f a removed device is still included in a discovery profile, then it will be rediscovered during the next
discovery task using that discovery profile.
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Managing software clients

Understanding software clients and software client
groups

There are two types of client software:

® Select'N'Send—This is a Windows application, including both a command line utility and a GUI version, that
allows users to send files directly to LDD and select LDD profiles to use in processing the sent files. Selected
files are submitted to the system in their current formats.

Note: Select'N'Send does not support prompting from an LDD server system profile.

® Lexmark Document Server Printer Port—This is a port monitor that allows users to submit documents to
LDD by printing from any Windows application to a print queue assigned to the port. Printed documents are
submitted to the system in the format determined by the print driver used with the print queue.

An LDD printer port can now be assigned to an LDD server system profile that prompts for user input at the
time of printing. The prompting is controlled by the profile or script running on the LDD server system that
the LDD printer port is assigned to. For LDD printer port prompting, the LDD port monitor software must be
installed on the computer. The LDD printer port must be created and assigned to a profile that prompts to
an existing print queue.

Notes:

— LDD printer port prompting is not supported on print servers. Do not configure an LDD port on a print
server to use a profile that prompts; otherwise, the spooler will stop responding and possibly crash
when print jobs start going into the print server. You can still use LDD ports on print servers, but you
can only assign them to profiles that do not prompt

— Configure the nonprompting profiles in the SDK with a property in the SDK that specifies that the
profile does not prompt. This helps improve the performance of an LDD port assigned to a
nonprompting profile. For more information on the nonprompting setting for software profiles, see
the Lexmark Document Distributor SDK Guide

A software client is a computer that has been configured to use Select'N'Send or a Lexmark Document Server
Printer Port to access solutions directly. A software client group is a collection of these software clients that
share one or more solutions with the same local configuration. At least one software client group must be
created for solutions used with Select'N'Send or Lexmark Document Server Printer Ports. Multiple software
client groups should be created if more than one solution is assigned to different sets of software clients or if
one solution is assigned to different software clients with different local configurations.
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Software clients can be members of more than one software client group. Solutions from each software client
group to which a software client belongs will be available to that software client.

© Global

-eSF
-3rd party jar files
Status Page

Software Client Software Client Software Client

Solution 1
Configuration A &
Solution 2
C B

Solution 1 Configuration C

Solution 1 Solution 2
C A Confi B

Solution 2 Configuration D

Although software client groups are similar to device groups, there are a few differences:
® Only solutions developed specifically for use with software clients may be made available to software clients.

® Software clients are not discovered. Adding a software client to a software client group simply enables
access to the solutions in that group when the software client accesses the system.

® Similarly, policy updates are not used with software clients.
® Lexmark Document Server Printer Port supports dynamic prompting.
® The Solution Status Page cannot be associated with a software client group.

Note: Separate client licenses are required for using software clients in LDD. For more information about
adding licenses to an existing system, see “Adding licenses to an existing server” on page 62.

Understanding dynamic prompting support

When a profile is selected, solutions usually either prompt you for information or start a job. Many solutions
involve submitting jobs with related information (such as account numbers, passwords, or processing options)
that is obtained through prompting. Where possible, prompting should occur before submitting the job. This
gives you the opportunity to cancel jobs when prompted for information they don't have at the moment.

The Job Submission Web Service provides prompting capability to Lexmark Document Server Printer Port
clients. From the port monitor, the following prompts are supported:

® MessagePrompt

® BooleanPrompt

® IntegerPrompt

® ListPrompt

® ArrayPrompt

® PasswordPrompt
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® ScanPrompt
® MessagePrompt

¢ EndPrompt

When the prompt wizard appears on the client screen, you can respond to the prompt within 30 seconds before
it times out. Prompting depends on whether or not there are any more required information or documents to
process. If there are more, then the end user is asked whether to continue or not. When the user reaches the
last prompt, a summary dialog of the answers appears. The user can then choose to send or cancel the job.

You can cancel the job at any time, although cancelling the job cannot undo the job application processing that
has already taken place.

Note: LDD 4.6.3.x printer ports on a clustered print server is not supported.

Understanding software client setup

Preparing software clients for use with LDD solutions requires a slightly different process than setup and
solution deployment for printers.

After installing other LDD system components, do the following:

1 Upload a solution to LDD. For more information, see “Uploading solutions to the LDD system” on page 81.

2 If necessary, install client software licenses on the LDD system. For more information, see “Adding licenses
to an existing server” on page 62.

3 Create a software client group to contain software clients to which a particular solution should be available.

4 AddIP addresses to the software client group for the computers where you want to install the client software
and solution.

5 Add the solution to the new software client group.

Note: Only solutions developed for use with client software (instead of, or in addition to, printers) may be
made available to software client groups.

6 Install client software on each of the client computers. For more information, see “Installing client software”
on page 103.

Note: Servers must be set online to install the client software successfully.

7 Run Windows Update to make sure the latest updates for the .NET framework are installed.

8 When using Lexmark Document Server Ports, add print queues assigned to the appropriate Lexmark
Document Server Port on each client computer or print server.

Note: Do not configure an LDD port on a print server to use a profile or script that prompts.

9 Test all print queues that use Lexmark Document Server Ports. For more information, see “Using LDD print
queues” on page 108.

10 Use test jobs to complete setup of Select'N'Send from each client. For more information, see “Using the
Select'N'Send GUI” on page 109.
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Creating and populating software client groups

Creating a software client group
1 Click the Software Client Groups tab.
2 Click Add from the Software Client Groups list.

3 Type a unigue name for the new software client group, and then click Add.

Adding software clients to a software client group
1 Click the Software Client Groups tab.

2 Select a software client group from the Software Client Groups list.

3 Select Client Profiles from the Tasks list.

4 Type an IP address, address range, subnet, or fully qualified domain name in the Address field.

'Address format Example

IP address 10.10.2.100

IP address range 10.10.2.1-10.10.2.127
Subnet 10.10.2.%*

Fully qualified domain name | client-hostname.domain-name

5 Click Add.

Notes:

® Software client groups manage software clients by IP address and do not require discovery.

* When adding a software client that will be installed on a Microsoft Cluster Server, add the IP address of
the logical host, as well as the IP addresses of all physical nodes in the cluster.

Importing software clients to a software client group
Software clients can be imported from a from an XML, TXT, or CSV file.

1 Click the Software Client Groups tab.
Select a software client group from the Software Client Groups list.
Select Client Profiles from the Tasks list.
Click Import.

Type the path of the file, or click Browse, and then locate the file.

o U1 A W N

Click Upload.
The entries in the file are added to the list of software clients.
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In a CSV and TXT file, each line must contain a single IP address of a software client. An XML file is structured
like the following example:

<?xml version="1.0" encoding="UTF-8" ?>
<filters>
<filters>
<address>10.10.2.200</address>
</filters>
<filters>
<address>10.10.2.150</address>
</filter>
</filters>

Assigning solutions to a software client group

Assigning a solution to a software client group grants the software clients in the group access to the solution
on the server, which allows users of these software clients to execute jobs using the solution.

1 Click the Software Client Groups tab.

2 Select a software client group from the Software Client Groups list.
3 Select Solutions from the Tasks list.

4 In the main section, click Add.

5 Select the solution from the list, and then click Next.

6 Configure the local settings of the solution for the current software client group, and then click Finish.

Installing client software

Do the following on a client computer or print server:

1 From the installation package, run Setup.exe.
Click Install Enterprise System > Install Client Software.
Click Agree to accept the license agreement.

Make sure Client Software is selected and highlighted. If necessary, specify a location for the installation.
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To include Select'N'Send in the installation, select Select'N'Send from the list.
Note: Do not install Select'N'Send on a print server.

6 To include the Lexmark Document Server Port in the installation, select the Lexmark Document Server
Printer Port check box.

7 Click Finish, and then allow the installation to complete.
8 If prompted, select Yes to restart the computer. Otherwise, click Done to finish the installation.

9 Run Windows Update to make sure the latest updates for the .NET framework are installed.
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Installing client software on a Microsoft Cluster Server

Note: For more information on the latest LDD port monitor support, see the Readme file.
1 Set any online Print Spooler resource offline to avoid initiating a failover during installation.
2 |Install only the Lexmark Document Server Printer Port on each physical node in the cluster.
3 Run Windows Update on each node to make sure the latest updates for the .NET framework are installed.
4 If necessary, configure the spooler resource and the LDD Client Service for the cluster.

Note: Make sure the spooler resource and the LDD Client Service are in the same cluster resource pool
so that failover is initiated together.

5 Create print queues on the cluster, selecting Lexmark Document Server Port - Enterprise as the port.

Note: For more information on creating print queues, see “Configuring a Lexmark Document Server
port” on page 105.

Adding LDD printers on a client workstation or print server

After installing the client software, you must create a separate Lexmark Document Server Printer Port for each
profile you want to use on an LDD server, and you must create a print queue assigned to that port.

1 Make sure you have installed the print driver that will be used with the Lexmark Document Server Printer
Port.

Note: If you do not have a specific print driver that you plan to use with the Lexmark Document Server
Printer port, then you can use the PCL or PostScript Lexmark Universal Driver appropriate for your
operating system, available at http://support.lexmark.com.

2 Make sure at least one server is online using the System Status task from the System tab in LMC.
Using the Printers or Devices control panel in Windows, add a new printer.

Note: For more information on adding a new printer, see “Configuring a Lexmark Document Server port”
on page 105.

4 When prompted, select a local printer and do not allow Windows to search for plug-and-play printers.

5 When prompted to select a printer port, create a new port of Lexmark Document Server Port - Enterprise
type.

6 Type a name for the new port, and then click Next. The port name must be 75 characters or fewer.

7 Select a Lexmark Document Server.
If the client software is newly installed, then the list is empty.
Do the following to add a new server:

Click Manage List.

T

From the Server Setup dialog, click Add.
Type the fully qualified domain name or IP address of the load balancer, and then click OK.
Click OK to exit the Server Setup dialog.

Select the new server from the list.
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8 Click Next.
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9 Select a profile on the server to use with the new port, and then click Next.
Notes:

® Do not configure an LDD port on a print server to use a profile that prompts. Prompting profiles
should be used only on client computers.

® Only profiles associated with solutions created for software clients are available.

® Profiles used with the Lexmark Document Server Port must have a name with 14 characters or fewer.
For more information on setting the name of a profile, see the Lexmark Document Distributor SDK
Guide.

® [fthe server is currently running a large number of jobs, then profiles on the server may not appear
on the list. Wait until the server is not as busy, and then try adding the port again.

10 Click Finish to add the new port.

11 Select an existing print driver, and then click Next. For more information, see the documentation that came
with the printer or print driver.

12 If you are asked whether to keep the existing driver, then select Keep existing driver (recommended), and
then click Next.

13 Type a printer name that describes the profile used with the new printer.

Select whether to use the new print queue as the default, and then click Next.

14 Select whether to share the new print queue. If you are installing the print queue on a server, then select
Share name, and then type a name to use for the print queue on the network.

15 Click Next.

16 Select No to skip printing a test page.

17 Confirm the settings for the new printer, and then click Finish.

18 After the printer has been added, right-click it in the Printers control panel, and then click Properties.
19 Click the Advanced tab.

20 Selectthe Spool print documents so program finishes printing faster and the Start printing after last page
is spooled check boxes.

Note: These settings are required in order to report an accurate page count to the LDD system, which
may be used by some solutions. Additionally, if a large job needs significant time to spool, smaller jobs
can still complete while the large job is spooling.

21 Click OK.

Configuring a Lexmark Document Server port
Note: Make sure to log in as an administrator.
Creating a print queue

1 Open the printers folder, and then add your printer.

2 Follow the instructions on the computer screen.
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Configuring an existing print queue
1 Open the printers folder, and then select your printer.

2 Open the printer properties.

3 From the Ports tab, configure or add a Lexmark Document Server port.

Increasing LDD print queue availability

Printer pooling provides a single print queue to several users and can prevent backups when large jobs are
submitted.

1 From the print queue, open the printer properties.
2 From the Ports tab, select Enable printer pooling, and then add a Lexmark Document Server port.
3 Select the Lexmark Document Server port created for the selected printer, and then click Next.
4 Select the profile used for the port created for the selected printer, and then click Next.
Notes:

® Do not select a profile that prompts.
® |f the server is running many jobs, then profiles on the server may not appear in the list. Wait until the
server is ready, and then try adding the port again.

5 Follow the instructions on the screen.

Note: You can add more Lexmark Document Server ports, and then add them to the same profile.

6 Apply the changes.
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Testing and using Lexmark Document
Distributor solutions

Using a solution from a printer

After a solution is deployed to a printer, a profile is available on the printer that allows users to access the
solution.

If the profile that you want appears on the home screen, then touch the icon for the profile.
If the profile that you want does not appear on the home screen, then do the following:

1 Touch Held Jobs.

Copy E-mail
Bl &8
= ' -
) Fax Job Applications
Search

Held jobs __Held jobs

=

e ]
=
—
!'_; | Status/ Power Saver Menus
Eupnlias Touch any button to begin E‘u

2 Touch Profiles.
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3 Touch the profile that you want to appear on the home screen.

Held jobs —> Profiles

(\5 Invoice (Type 1)
& Invoice (Type 2)
Invoice (Type 3)

Search
Profiles

Job Applications

Resumes

Tax Records

f’ Displaying 1-6 / 7 /:E"; f‘a : B¢¢;

The profile launches the associated script on the server. Documents are scanned as necessary, and any
prompts included in the script are presented to the user.

CRRRER

Note: When using a solution that reads a bar code, scan at 300 dpi for best results. Depending on the
documents being scanned, using a higher setting for Darkness may also provide better results.

Using LDD print queues
1 With a document open in Windows, click File > Print.
2 Select the printer associated with the Lexmark Document Server port and the profile you want to use.

3 To configure print options, click Properties, Preferences, Options, or Setup.
See the documentation that came with the printer or print driver for more information about print options.

Note: When using a solution that reads a bar code, print at 300 dpi, with any other quality settings at the
highest levels for best results.

4 Click OK to close any printer software dialogs.

5 Click OK or Print.

The document is sent to the LDD system using the profile specified in the configuration of the Lexmark
Document Server port associated with the selected printer. The file type is determined by the output of the
print driver, and each solution determines the accepted file types.
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Using Select'N'Send

Using the Select'N'Send GUI

The graphical user interface (GUI) version of Select'N'Send lets users access a selection of LDD profiles, and
submit various documents and document types to the LDD system. Selected files are submitted to the system
in their current formats. Each solution script determines which file types are acceptable. For more information,
contact the developer of your solution.

1 Launch the Select'N'Send GUI.

Do one of the following:

* From Windows Explorer, right-click the file that you want to submit to Lexmark Document Distributor,
and then click Send To > Lexmark Document Distributor Enterprise.

_J Test Files _JIOJE3
Fle Edt Wew Favortes Tools Help "
(D ark ~ 5 Search Foiders [T
) Ci\Test Files v B
tost ek
File and Folder Tasks 3 B cpen
1KB
S Rename this file P!”t
Edit
S Move this fils
Q Copy this File Scan for Yiruses. ..
& Publish this il to the Wieb @Ozj” it 4
fudd to Zip
E-mail this fil
o ) Add to test.zip
Ly Prink this Fils
. Delete this file Sl o * (£ Compressed (zipped) Folder
cut (& Deskrop {create shorteut)
Oth e Pl x Copy & Lexmark Document: Distributor Enterprise [%
Create Shortout ) Mail Recipient

e WINGP (C:) Delete

) My Documents
) My Documents Rename

: <L, DVDICD-RW Drive (D)
g My Computer Properties =
&3 My Network Places

Details ¥

® Fromthe command line, type sendservent filename, where filename is the file that you want to
submit to Lexmark Document Distributor, and then press Enter.

Note: The Select'N'Send program folder is added to the system path during installation so that
Select'N'Send can be accessed from any folder at the command line.

B C:\WINDOWS\system3 2\emd. exe - ﬂ

C:“Test Files>sendservent test.txt
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® Drag the file that you want to submit to Lexmark Document Distributor onto the sendservent.exe file or
to a shortcut pointing to that file.

) Test Files M=
i

File Edt Wiew Fawortes Tooks  Help

Q= - -3 /' Search Foiders [T

Address |29 C:\Test Files v B

p T taskib Shorteut to sendssrvent exe
File and Folder Tasks & —— | Text Document g Shartout
=) Rename this file == HH L Tk

3 Move this s

) Copy this file

8 Publish this file to the web

(23 Email this il

&y Prink this file

% Delete this il

Other Places £

e WINKP (C2)
[} My Documents
3 My Computer
& by Metwork Flaces

Details ¥

Type: Text Document Date Modified: S{12{2008 3:50 PM Size: 90 bytes 90 bytes 4 My Computer

2 From the Lexmark Select'N'Send window, select a Lexmark Document Server.

Lexmark Select N Send

File: | chbest.kxt

Document 5 erver

|My Server - Setup...

Server Profiles

i

Select the profile to uze with thiz image: Refrezh
Mame Description
iSecursbichive

Ok | Cancel |

If the client software is newly installed, then the list is empty.
Do the following to add a server:

a Click Setup.

b From the Server Setup window, click Add.

¢ Type the fully qualified domain name or IP address of the server, and then click OK.



Testing and using Lexmark Document Distributor solutions m

d Click OK to exit the Server Setup dialog.
e If necessary, select the new server from the list.

3 Select a profile from the Server Profiles list, and then click OK.

Using Select'N'Send from the command line

The command line version of Select'N'Send is useful for automated processes and accessing LDD profiles from
other software, such as Windows Small Business Server, or for creating batch files that help users submit specific
files using specific profiles.

Use this command to run the command line version of Select'N'Send:

sendservent -s server -p profile -f filename [-u userdatafile -t timeout -i
intervall

Options
server—This is the IP address or fully qualified domain name of the load balancer LDD system.
profile—This is the profile to run on the LDD server.
filename—This is the path and file name of the file to be submitted to the LDD system.

Note: The specified file is submitted to the system in its current format. Each solution script determines
which file types are acceptable. For more information, contact the developer of your solution.

userdatafile—This is the path and file name of a file containing user information for the job. This is
optional.

Note: Though a user data file is optional, a script that expects user data fails if no user data file is
specified or if expected data is missing from a specified file.

timeout—This is the time in seconds to wait for confirmation from the LDD system before aborting the
operation with an error. This is optional. The default is 0, which specifies no timeout.

interval—This is the time in seconds to wait between each instance of polling the LDD system for
confirmation. This is optional. The defaultis 0. 5.

Note: Any option that contains a space should be enclosed in double quotation marks (").

Scheduling scripts

Some solutions include scripts that can be set to run on a schedule. Additionally, some scripts can be associated
with a device group or software client group in order to use local settings associated with that group.

1 Click the System tab.

2 Select Schedule from the System list.

3 Click Add > Script.

4 Type a description for the task, and then click Next.

5 Select whether to associate the scheduled script with a device group or software client group:
® To associate the script with a device group:
a Click DeviceGroup, and then click Next.
b Select the device group to associate the script with, and then click Next.
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® To associate the script with a software client group:
a Click SftClientGroup, and then click Next.
b Select the software client group to associate the script with, and then click Next.

® To schedule the script without associating it with a device group or software client group, click None,
and then click Next.

A scriptthatis not associated with a device group or software client group can access only global solution
settings.

Select a solution, and then select a script.

If the script applies to individual servers rather than the system as a whole, such as a script that deletes
certain files from a server, or a script that runs a report with server-specific information, then click Run on
All Servers.

If the script uses information supplied in the Additional Options field, then type the necessary information.
For more information, contact the developer of the solution.

Click Next.
Enter a start date and a start time.

Configure the frequency of the scheduled event, and then click Finish.
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Viewing logs

Viewing installation logs

1 From the computer where LDD is installed, open the Windows Run dialog box, and then type
"%ALLUSERSPROFILE%\Lexmark\LDD4x".

2 Open the log files in a text editor.

Viewing the server log

All server activity at the selected message priority is recorded in the file Isas.log in the folder Lexmark\Solutions
\tomcat\logs where the server is installed. Open the file in a text editor to view the log.

The default message severity for recording is warn. When troubleshooting a problem, the message priority
can be changed to debug to capture all available messages:

1 Click the System tab in LMC.

2 Setthe server for which you are changing the message priority offline. Make sure the server is offline before
proceeding. Click Refresh, and then make sure of£1ine is reported in the Status column for the server.

3 In a text editor, open the file logdj-lsas.xml from the folder Lexmark\Solutions\apps\wf-Idss\WEB-INF
\classes where the server is installed.

4 In the following lines, change "warn" to "debug":

<!-- Root Logger. -->
<root>
<priority value="warn" />

5 Save and close the file.

6 Fromthe Windows Services control panel on the server computer, restart the Lexmark Solutions Application
Server service.

7 From the System tab, set the server online. For more information, see “Viewing and changing server status”
on page 52.

Note: After recording the necessary data, the message priority should be changed back to warn to save
disk space.

Viewing the Embedded Solutions Diagnostic Log

All activity for solutions and eSF applications is recorded in the Embedded Solutions Diagnostic Log on each
printer.

1 Inthe address field of your Web browser, type http: //printer-IP/se, where printer-IPis the printer
IP address or host name.

2 Click Embedded Solutions > Log File.
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By default, debugging messages are not recorded. When troubleshooting a problem, you can enable
debugging entries in the log to capture all available messages:

1 Inthe address field of your Web browser, type http://printer-IP/se,where printer-IPisthe printer
IP address or host name.

2 Click Embedded Solutions > Set Logging Level > Set Logging Level > Yes > Submit.

Note: After recording the necessary data, you must change the logging level back to Default to avoid
excessive log entries.
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Troubleshooting

Solving LMC problems

The browser displays a 5yy error when accessing LMC

When services are starting on the system or the system is under a heavy processing load, your browser may
display a 5yy error, such as “500 Internal Server Error” or "503 Service Unavailable," when you try to access
LMC.

1 Make sure the system has been running long enough for all services to start. It may take several minutes
to start all services when the system is first booted. If the system is recently booted, or the load balancer is
overloaded, then wait a few minutes, and then try again.

2 Ifthe load balancer is under a heavy processing load, then try again when the system is processing fewer
jobs.

3 Determine whether a problematic server installation is causing LMC to be inaccessible through the load
balancer:

a Access LMC directly on each server using the URLhttp://server: 9788 /1lmc, where serveris the
computer where the server is installed.

b If you can successfully access LMC directly on a server, then use the System Status task on the System
tab to determine whether any of the servers in the system are not communicating.

c If any server is not communicating, then uninstall it from the computer where it is installed.

Note: If this is not possible, or if the entry remains after uninstalling, then select the
non-communicating server or servers in LMC, and then click Remove Server(s).

d Access LMC using the load balancer address.

4 [f the issue is still not resolved, then uninstall and reinstall all components, making sure to enter correct
addresses for the database and load balancer where applicable.

LMC responds very slowly
Several servers that are not communicating may cause LMC to respond very slowly.
Determine whether non-communicating servers appear in LMC:

1 Access LMC directly on an active server using the URL http://server:9788/1lmc, where serveris
the computer where the server is installed.

2 Use the System Status task on the System tab to determine whether any of the servers in the system are
not communicating.

3 If any servers are not communicating, then select them from the list, and then click Remove Server(s).

4 Access LMC using the load balancer address.
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LMC does not finish loading or data is missing

If cookies are not enabled, then LMC may continue to display Loading for an extended period after logging
in, or data may be missing or incorrect on some screens.

Try one or more of the following:

® Make sure cookies are allowed for the address where you access LMC. Cookies must be enabled on your
Web browser in order to use LMC.

® Make sure you have Adobe Flash Player 10 or later installed. If your Web browser settings do not allow
ActiveX controls to run, then you must upgrade manually by visiting the Adobe Web site.

An error occurs when uploading a formset

Make sure you have Adobe Flash Player 10 or later installed. If your Web browser settings do not allow ActiveX
controls to run, then you must upgrade manually on the Adobe Web site.

Reports are not displayed when run
1 Make sure pop-ups are allowed for LMC in your Web browser.

2 Ifyou are running a PDF report, then make sure Adobe Reader is installed.

User cannot access some tasks in LMC

Check with the administrator if the group to which the user belongs has limited access to that task.

User can still access tasks even after privileges are removed

Check the Privileges settings of all the groups to which the user belongs. For more information, see “Assigning
privileges to groups” on page 41.

The Solutions tab and the eSF Configuration task for device groups do not
function

A descriptor file for an eSF application included with a solution may have contained tag names that included
colons. Multiple errors may have occurred while uploading the solution.

1 Contact Lexmark Professional Services for assistance in manually removing the solution that caused the
problem.

2 Contact the developer of the solution to have colons removed from descriptor files for associated eSF
applications.

3 Reinstall the solution.



Troubleshooting 17

Jobs do not respond after an error occurred

If an error occurred while a job is being processed, then stop the specific job. This terminates the job that is no
longer responding but is still marked as running in LMC.

1 Click the System tab.
2 Select Jobs from the System list.

3 Select the tasks that do not respond, and then click Stop Task.

Solving discovery problems

Discovery and policy updates running slowly

1 Check your proxy, firewall, and other network settings on system components to make sure all necessary
communication is allowed.

2 Make sure other network traffic is not reducing bandwidth during discoveries and policy updates.

If you have three or more servers in your system, then try reducing the chunk size using the General service
on the Services tab. A value as low as 2 may improve performance.

4 Toreduce the time waiting for non-responsive printers during policy updates, reduce the timeout per device
using the PolicyUpdate service on the Services tab.

Note: If you are deploying solutions that include large eSF applications or several eSF applications, then
a lower setting may not allow enough time to successfully validate eSF application deployment.

5 If you are discovering printers for subsequently added discovery profiles in a device group or groups in
which you have previously discovered printers, then select Discover new devices only to skip any IP address
where a printer has been discovered.

Discoveries frequently time out

1 Check your proxy, firewall, and other network settings on system components to make sure all necessary
communication is allowed.

2 Make sure other network traffic is not reducing bandwidth during discoveries and policy updates.

3 Ifyou have three or more servers in your system, then try increasing the initial timeout and retry times using
the NPA service on the Services tab. Type a timeout period in milliseconds for each retry in sequence,
separating each by a space in the NPANT Timeout field.

Some printers on the network cannot be discovered

1 Check your proxy, firewall, and other network settings on system components to make sure all necessary
communication is allowed.

2 From the Services tab, make sure the read community name and write community name for the SNMP
service match the printers on the network. All printers used in the system must use the same read community
name and write community name.
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3 From the Device Groups tab, make sure the discovery profile settings of the discovery profile are correct.
For more information, see “Discovering printers” on page 88.

Solving server and printer problems

One or more servers cannot be set online

Try one or more of the following:

® Make sure a license is installed for each server during installation. For more information about activating
licenses, see “Obtaining licenses” on page 20. For more information about adding licenses after installation,
see “‘Adding licenses to an existing server” on page 62.

® Check your proxy, firewall, and other network settings across the LDD system to make sure communication
is allowed among components.

® Uninstall and reinstall the problem server making sure to enter correct addresses for the database and load
balancer. Note that when the server is installed on the same computer as the database and the load
balancer, the fully qualified domain name of the computer must still be used, not localhost or the loopback
address (127.0.0.1).

® Make sure the correct address is used for the database when installing the load balancer. Note that when
the load balancer is installed on the same computer as the database, the fully qualified domain name of the
computer must still be used, not localhost or the loopback address (127 .0.0.1). If the address is specified
incorrectly, then uninstall and reinstall the load balancer and all servers.

Note: Multiple non-communicating servers may impact system performance. If you do not expect a
non-communicating server to quickly reestablish communication, then you should remove it. To remove a
server that is not communicating, select the check box beside it in the table, and then click Remove
Server(s).

One or more servers cannot be set offline

From the Windows Services control panel, make sure the Lexmark Solutions Apache Agent service is running.

Error in importing a license

Try one or more of the following:

® Make sure the correct address is used for the database and load balancer when installing servers. Note
that when the server is installed on the same computer as the database and the load balancer, the fully
qualified domain name of the computer must still be used, not localhost or the loopback address
(127.0.0.1). If the address is specified incorrectly, then uninstall and reinstall the applicable servers.

® Make sure the correct address is used for the database when installing the load balancer. Note that when
the load balancer is installed on the same computer as the database, the fully qualified domain name of the
computer must still be used, not localhost or the loopback address (127 .0.0.1). If the address is specified
incorrectly, then uninstall and reinstall the load balancer and all servers.
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LDSS Server is unavailable message appears on the printer control
panel
1 Make sure the system has been running long enough for all services to start. It may take several minutes

to start all services when the LDD system is first booted. If the system was recently booted, then wait a few
minutes, and then try again.

2 Make sure the LDD system and all servers are online:
a LogontoLMC.
b Click the System tab.
Cc If necessary, select System Status from the System list.
d

Look in the Status column for offline servers, and set servers online as necessary. For more information,
see “Viewing and changing server status” on page 52.

3 Make sure the solution you are attempting to access exists in the system and has been properly deployed
to a device group containing the printer:

a LogontoLMC.
b Click the Solutions tab.

Cc Select the solution you are trying to access from the printer.

If the solution does not appear, then install the solution. For more information, see “Uploading solutions
to the LDD system” on page 81.

d If necessary, select the Summary task.

Make sure a device group that contains the printer appears beside Device Groups in the Summary
section.

If no device group containing the printer appears, then make sure the printer is added to a device group,
and then deploy the solution to that device group. For more information, see “Deploying solutions to a
device group” on page 89.

f Perform a policy update. For more information, see “Updating policies for device groups” on page 94.

4 Ifyou are using an e-Task 2 printer, make sure the correct version of the Advanced Prompting Bundle (AP
Bundle) is installed, especially if you have upgraded your LDD system from version 4.5 or earlier:

a Type the printer IP address or host name in the address field of your Web browser.

Note: If you do not know the IP address or host name of the printer, then you can:

® View the information on the printer control panel home screen, or in the TCP/IP section under the
Networks/Ports menu.

® Print a network setup page or menu settings page and locate the information in the TCP/IP section.
b Click Settings > Embedded Solutions.

Make sure that the first two segments of the version number beside AP Bundle match the version number
of the LDD system. For version 4.6, the version of the AP Bundle should be 4.6.x.

d If the version numbers do not match, then do the following:

1 Make sure the printer access controls are not preventing policy updates from working correctly:
a Type the printer IP address or host name in the address field of your Web browser.

Note: If you do not know the IP address or host name of the printer, then you can:
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* View the information on the printer control panel home screen, or in the TCP/IP section under
the Networks/Ports menu.
* Print a network setup page or menu settings page and locate the information in the TCP/IP
section.
b Click Settings > Security > Security Setup > Access Controls > Management.
¢ Select No Security from the Firmware Updates drop-down menu, and then click Submit.
2 In LMC, perform a policy update. For more information, see “Updating policies for device groups” on
page 94.
or
Install the Advanced Prompting Bundle manually:
a Type the printer IP address or host name in the address field of your Web browser.

Note: If you do not know the IP address or host name of the printer, then you can:
* View the information on the printer control panel home screen, or in the TCP/IP section under
the Networks/Ports menu.
® Print a network setup page or menu settings page and locate the information in the TCP/IP
section.
b Click Settings > Embedded Solutions > Install > Install.

¢ Locate and select the file ap.fls in the folder \Lexmark\Solutions\apps\wf-ldss\firmware\ where
an LDD server is installed, and then click Open > Start Install.

5 Review the Embedded Solutions Diagnostic Log to make sure the printer can resolve the server host name.
For more information, see “Viewing the Embedded Solutions Diagnostic Log” on page 113.

6 Check your proxy, firewall, and other network settings on LDD components to make sure all necessary
communication is allowed.

The server log contains Quartz errors
Make sure to synchronize the time on all computers used in the LDD system before installing LDD components.
If the time is not synchronized, then do the following:
1 Uninstall all components.
2 Synchronize the time on all computers using an NTP server.

3 Reinstall all components.

Kerberos authentication is not working
Make sure that the date and time on the printer, LDD server, and KDC server are correct and synchronized.

To log Kerberos debug messages from the Java Virtual Machine on each server, add the line
-Dsun.security.krb5.debug=true to the Windows registry key HKEY_LOCAL_MACHINE\SOFTWARE

\Apache Software Foundation\Procrun 2.0\Tomcat7\Parameters\Java\Options.

For 64-bit Windows operating systems such as Windows Server 2008 R2 x64, the registry path is
HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation\Procrun
2.0\Tomcat7\Parameters\Java\Options.

Note: Do not delete the existing contents of the registry key.
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Warning—Potential Damage: Incorrectly editing the Windows registry may damage your Windows
installation and result in an unusable system. Make sure that you understand how to make the required
changes. We recommend backing up the registry before making any changes.

Debug messages are logged in the file tomcat7-stdout.yyyy-mm-dd.log in the \Lexmark\Solutions\tomcat\logs
\ folder where the LDD server is installed.

Solution or profile icon does not appear on the home screen

Try one or more of the following:

From the printer control panel, refresh the home screen by moving to another screen and then returning to
the home screen.

If the home screen has multiple pages available, then make sure that the icon does not appear on other
pages.

If the profile is available in the printer held jobs menu and its icon is missing, then make sure to customize
the home screen appropriately.

1 Click the Device Groups tab.

2 Select a device group from the Device Groups list.
3 Select Home Screen from the Tasks list.
4

Click the device class tab that matches the device class of the printer.
For more information on device classes, see “Supported printers” on page 14.

gl

Select Use this home screen as part of the device groups policy.

Make sure to select a layout other that the default, and that the profile has been assigned to a button.
For more information on customizing the home screen, see “Customizing the home screen for a device
group” on page 90.
If the profile does not appear in the printer held jobs menu, then make sure to set up the device groups
correctly and update the policies.

1 Make sure that the solution has been properly deployed to a device group containing the printer.
For more information, see “Deploying solutions to a device group” on page 89.

(9}

2 Perform a policy update. For more information, see “Updating policies for device groups” on page 94.

For e-Task 2+, e-Task 3, and e-Task 4 printers, make sure that the missing icon is enabled in the printer
settings:

Note: For a list of e-Task 2+, e-Task 3, and e-Task 4 printers, see “Supported printers” on page 14.

1 Open a Web browser, and then type the printer IP address.

Note: Locate the IP address on the printer home screen.
2 Click Settings > General Settings > Home screen customization.
3 Select the item that corresponds to the missing icon, and then click Submit.
Make sure that the printer Access Controls are not preventing policy updates from working correctly.
1 Open a Web browser, and then type the printer IP address.

Note: Locate the IP address on the printer home screen.
2 Click Settings > Security > Security Setup > Access Controls.
3 Click Management, and then select No Security from the Remote Management menu.

4 Click Function Access, and then select No Security from the Create Profiles menu.
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5 Click Submit.

6 In LMC, perform a policy update. For more information, see “Updating policies for device groups” on
page 94.
® |f you are using custom icons, then use smaller files.

® Make sure that your printer has the latest firmware updates. For more information, contact Lexmark
Professional Services.

Policy updates failed for a printer

After a policy update, the printer remains marked “Out of Policy,” and the system log contains the message
Policy not deployed to xxxX.XXX.XXX.XXX.

1 If the printer uses a basic security template with a password or PIN, then configure the device security
service for the printer. For more information, see “Configuring device security” on page 61.

2 Make sure that the printer access controls are not preventing policy updates from working correctly.
a Open a Web browser, and then type the printer IP address.

Note: Locate the IP address on the printer home screen.
Click Settings > Security > Security Setup > Access Controls.
Click Management, and then select No Security from the Remote Management menu.
Click Function Access, and then select No Security from the Create Profiles menu.
Click Submit.

In LMC, perform a policy update. For information, see “Updating policies for device groups” on page
94.

- O O 0N T

The printer only returns to the home screen after attempting to execute an
LDD profile

If the Advanced Prompting Bundle is not installed or running, then the printer appears to be in policy after a
policy update, but the printer may only return to the home screen when you attempt to execute an LDD profile.

1 Determine whether the Advanced Prompting Bundle (AP Bundle) is installed correctly:
a Type the printer IP address or host name in the address field of your Web browser.

Note: If you do not know the IP address or host name of the printer, then you can:

® View the information on the printer control panel home screen, or in the TCP/IP section under the
Networks/Ports menu.

® Print a network setup page or menu settings page and locate the information in the TCP/IP section.
b Click Settings > Embedded Solutions.
c Ifthe AP Bundle does not appear in the list of installed solutions, then continue with the troubleshooting
procedure.

Note: If the AP Bundle is already installed, then make sure it is in a running state. Otherwise, the
problem may be with the solution itself. Contact the developer of the solution for assistance.

2 Ifthe printer uses basic security template with a password or PIN, then configure the device security service
for the printer. For more information, see “Configuring device security” on page 61.
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3 Make sure the printer access controls are not preventing policy updates from working correctly:

a Type the printer IP address or host name in the address field of your Web browser.

Note: If you do not know the IP address or host name of the printer, then you can:

* View the information on the printer control panel home screen, or in the TCP/IP section under the
Networks/Ports menu.

* Print a network setup page or menu settings page and locate the information in the TCP/IP section.
b Click Settings > Security > Security Setup > Access Controls > Management.
c Select No Security from the Firmware Updates drop-down menu.
d Click Submit.
4 |In LMC, perform a policy update. For more information, see “Updating policies for device groups” on

page 94.
or

Install the Advanced Prompting Bundle manually:
a Type the printer IP address or host name in the address field of your Web browser.

Note: If you do not know the IP address or host name of the printer, then you can:

® View the information on the printer control panel home screen, or in the TCP/IP section under the
Networks/Ports menu.

* Print a network setup page or menu settings page and locate the information in the TCP/IP section.
b Click Settings > Embedded Solutions > Install > Browse.

Locate and select the file ap.fls in the folder \Lexmark\Solutions\apps\wf-Idss\firmware\ where an LDD
server is installed, and then click Open.

d Click Start Install.

The solution stops responding
If the network connection is lost on some printers, then the solution may stop responding.

1 Make sure the network cable is plugged into the printer and into the appropriate network outlet.
2 Wait a few minutes to see if the network connection returns, and then access the solution.

3 If the solution does not continue, then do the following:
a Turn off the printer.
b Wait a few seconds, and then turn the printer on.

¢ Check the printer network settings and the status of the network. For more information, see the
documentation that came with the printer. For help with your local network, contact your network
administrator.

The solution cannot connect to the network

Check the local domain settings in the proxy server settings of the printer. If necessary, add the domain on the
local network that will bypass the proxy server.
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Solving client software problems

Cannot create new Lexmark Document Server ports

1 Make sure at least one server is online using the System Status task on the System tab in LMC.
2 Make sure you have a license installed for software clients:

a Click the System tab.

b Select Licenses.

¢ Make sure one of the listed licenses applies to clients, and is not expired.

For more information, see “Obtaining licenses” on page 20.

3 Make sure the IP addresses or subnets of the computers that will access the profile and a solution have
been assigned to a software client group.

For more information, see “Assigning solutions to a software client group” on page 103.

4 Check your proxy, firewall, and other network settings on the client computer to make sure communication
is allowed with the LDD load balancer.

System processes terminate unexpectedly when creating a Lexmark
Document Server port
If a profile assigned to Lexmark Document Server port has a name with more than 14 characters, or if the port

name used has more than 75 characters, then the processes explorer.exe and spoolsv.exe may terminate
unexpectedly.

1 If a port was created before the error occurred, then delete the port using the Ports tab of the Properties
dialog for the created print queue.

Note: For more information on accessing the properties for the Lexmark Document Server port, see
“Configuring a Lexmark Document Server port” on page 105.

2 |If the profile used with the port has a name with more than 14 characters, then change it to one that has 14
characters or fewer. For more information, contact the person who developed the solution, or see the
Lexmark Document Distributor SDK Guide.

3 Create a new port for the created print queue, using a name with 75 characters or fewer.

Restart the computer where you added the Lexmark Document Server port.

Cannot create or configure a Lexmark Document Server port

When User Account Control is enabled, install or configure the Lexmark Document Server port with
administrative privileges.

Do one or more of the following:
® Create a print queue using the Lexmark Document Server port.
® Configure or add a Lexmark Document Server port in an existing print queue.

Note: For more information, see “Configuring a Lexmark Document Server port” on page 105.
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Jobs are not sent to the LDD system when using LDD printers

1

Make sure you have created a new printer Lexmark Document Server Port and assigned a print queue using
an existing print driver to that port.

For more information, see “Adding LDD printers on a client workstation or print server” on page 104.

2 Make sure you have a license installed for software clients:

a Click the System tab in LMC.

b Select Licenses.
¢ Make sure one of the listed licenses applies to clients and is not expired.

For more information, see “Obtaining licenses” on page 20.

3 Make sure a solution has been properly deployed to a software client group containing the software client.

For more information, see “Assigning solutions to a software client group” on page 103.

4 Run Windows Update to make sure the latest updates for the .NET framework are installed.

5 Check your proxy, firewall, and other network settings on the client computer to make sure communication

is allowed with the LDD load balancer.

Select'N'Send cannot send files to LDD

1 Make sure you have a license installed for software clients:

a From the System tab in LMC, select Licenses.
b Make sure one of the listed licenses applies to clients and is not expired.

For more information, see “Obtaining licenses” on page 20.

2 Make sure a solution has been properly deployed to a software client group containing the software client.

For more information, see “Assigning solutions to a software client group” on page 103.

3 Check your proxy, firewall, and other network settings on the client computer to make sure communication

is allowed with the LDD load balancer.

Solutions are receiving inaccurate page counts

Try one or more of the following:

®* Make sure jobs are not sent until they are finished spooling:
1 From the Printers control panel in Windows, right-click the printer, and then click Properties.

2 Click the Advanced tab.

3 Selectthe Spool print documents so program finishes printing faster and Start printing after last page
is spooled check boxes.

4 Click OK.

® |f you are using Microsoft Word and a solution always receives a page count of 1, see the Microsoft
Knowledge Base article KB919736 The dmCopies member always returns a value of 1 when you try to
retrieve the number of copies in a print job in Word (http://support.microsoft.com/kb/919736).
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Appendix

Prompts supported by single-function printers

Single-function printers do not support all prompts supported by multifunction printers. Lists of supported
prompts are included in the table below.

Touch screen printers Non-touch screen printers

Supported prompts ® ArrayPrompt * ArrayPrompt
e AuthenticationPrompt’ ¢ AuthenticationPrompt" 2
® BooleanPrompt ® BooleanPrompt
® CustomVImIPrompt ® IntegerPrompt
® ImageBooleanPrompt ® ListPrompt
® |magelListPrompt ® MessagePrompt
® ImageMessagePrompt * NumericPrompt
* |ntegerPrompt ® PasswordPrompt3
e ListPrompt ¢ StringPrompt?
® MessagePrompt ¢ NullPrompt*
® NumericPrompt
® PasswordPrompt
® StringPrompt
® NullPrompt

"Requires a supported card reader.
2 Supported by T654 and W850 models only.

3 Supports only numeric PINs in e-Task printers. E-Task printers include C520, C522, C524, C530, C532, C534,
C732, C734, C736, C780, C782, C920, C935, E450, E460, E642, T640, T642, T644, T650, T652, W840.

4 Supported by e-Task printers only.

Double-byte character support

Not all printer models support double-byte characters. If your printer is not listed in the table below, it does not
support double-byte characters.

Printer model Simplified Chinese Traditional Chinese Japanese  Korean
C748 X X X
C792 X X X X
C925 X X X X
C950 X X X X
CS510 X X X X
CX410 X X X X
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Printer model Simplified Chinese Traditional Chinese Japanese Korean

CX510

MS610

MS810, MS812, MS9M
MX410, MX510, MX511
MX610, MX611

MX710, MX711

MX810, MX811, MX812
MX910, MX911, MX912
X463, X464, X466
X548

X642

X644, X646

X651, X652, X654, X656, X658
6500

X734, X736, X738
X746, X748

X782

X792

X850, X852, X854
X860, X862, X864
X925

X940, X945

X950, X952, X954

X | XX |X|X|X|X|X

X[ X[ X|X|X|[X|X|X]|X]|X
XX [X|X|X|IX|X|X]|X]|X

X | X | X | X

XX [X|X[|X|IX|X[X|X[|X|X|X[X|X|X[|X|X|X|X|X]|X]|X

x
X
XX [X|X[|X|X|X|X|X|X]|X]|X
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Notices

Edition notice

February 2015

The following paragraph does not apply to any country where such provisions are inconsistent with local
law: LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY
KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of
express or implied warranties in certain transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made
to the information herein; these changes will be incorporated in later editions. Improvements or changes in the
products or the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to
make these available in all countries in which it operates. Any reference to a product, program, or service is
not intended to state or imply that only that product, program, or service may be used. Any functionally
equivalent product, program, or service that does not infringe any existing intellectual property right may be
used instead. Evaluation and verification of operation in conjunction with other products, programs, or services,
except those expressly designated by the manufacturer, are the user’s responsibility.

For Lexmark technical support, visit http://support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

© 2015 Lexmark International, Inc.

All rights reserved.

Trademarks

Lexmark, Lexmark with diamond design, and MarkVision are trademarks of Lexmark International, Inc.,
registered in the United States and/or other countries.

All other trademarks are the property of their respective owners.

GOVERNMENT END USERS

The Software Program and any related documentation are "Commercial Items," as that term is defined in 48
C.F.R. 2.101, "Computer Software" and "Commercial Computer Software Documentation," as such terms are
used in 48 C.F.R. 12.212 or 48 C.F.R. 227.7202, as applicable. Consistent with 48 C.F.R. 12.212 or 48 C.F.R.
227.7202-1through 227.7207-4, as applicable, the Commercial Computer Software and Commercial Software
Documentation are licensed to the U.S. Government end users (a) only as Commercial ltems and (b) with only
those rights as are granted to all other end users pursuant to the terms and conditions herein.

The Apache Software License, Version 1.1

Copyright (c) 2000-2002 The Apache Software Foundation. All rights reserved.


http://support.lexmark.com
http://www.lexmark.com
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Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

1 Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

2 Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

3 The end-user documentation included with the redistribution, if any, must include the following
acknowledgment:

"This product includes software developed by the Apache Software Foundation (http://www.apache.org/)."

Alternately, this acknowledgment may appear in the software itself, if and wherever such third-party
acknowledgments normally appear.

4 The names "Apache" and "Apache Software Foundation", "Jakarta-Oro" must not be used to endorse or
promote products derived from this software without prior written permission. For written permission, please
contact apache@apache.org.

5 Products derived from this software may not be called "Apache" or "Jakarta-Oro", nor may "Apache" or
"Jakarta-Oro" appear in their name, without prior written permission of the Apache Software Foundation.

THIS SOFTWARE IS PROVIDED “AS IS" AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND
ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the Apache Software
Foundation. For more information on the Apache Software Foundation, please see http://www.apache.org/

Apache License Version 2.0, January 2004

http://www.apache.org/licenses/

TERMS AND CONDITIONS FOR USE, REPRODUCTION, AND DISTRIBUTION
1 Definitions.

"License" shall mean the terms and conditions for use, reproduction, and distribution as defined by Sections
1through 9 of this document.

"Licensor" shall mean the copyright owner or entity authorized by the copyright owner that is granting the
License.

"Legal Entity" shall mean the union of the acting entity and all other entities that control, are controlled by,
or are under common control with that entity. For the purposes of this definition, "control" means (i) the
power, direct or indirect, to cause the direction or management of such entity, whether by contract or
otherwise, or (ii) ownership of fifty percent (50%) or more of the outstanding shares, or (iii) beneficial
ownership of such entity.

"You" (or "Your") shall mean an individual or Legal Entity exercising permissions granted by this License.


http://www.apache.org/
http://www.apache.org/licenses/
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"Source" form shall mean the preferred form for making modifications, including but not limited to software
source code, documentation source, and configuration files.

"Object" form shall mean any form resulting from mechanical transformation or translation of a Source form,
including but not limited to compiled object code, generated documentation, and conversions to other
media types.

"Work" shall mean the work of authorship, whether in Source or Object form, made available under the
License, as indicated by a copyright notice that is included in or attached to the work (an example is provided
in the Appendix below).

"Derivative Works" shall mean any work, whether in Source or Object form, that is based on (or derived from)
the Work and for which the editorial revisions, annotations, elaborations, or other modifications represent,
as a whole, an original work of authorship. For the purposes of this License, Derivative Works shall not
include works that remain separable from, or merely link (or bind by name) to the interfaces of, the Work
and Derivative Works thereof.

"Contribution" shall mean any work of authorship, including the original version of the Work and any
modifications or additions to that Work or Derivative Works thereof, that is intentionally submitted to Licensor
for inclusion in the Work by the copyright owner or by an individual or Legal Entity authorized to submit on
behalf of the copyright owner. For the purposes of this definition, "submitted" means any form of electronic,
verbal, or written communication sent to the Licensor or its representatives, including but not limited to
communication on electronic mailing lists, source code control systems, and issue tracking systems that are
managed by, or on behalf of, the Licensor for the purpose of discussing and improving the Work, but
excluding communication that is conspicuously marked or otherwise designated in writing by the copyright
owner as "Not a Contribution."

"Contributor" shall mean Licensor and any individual or Legal Entity on behalf of whom a Contribution has
been received by Licensor and subsequently incorporated within the Work.

2 Grant of Copyright License. Subject to the terms and conditions of this License, each Contributor hereby
grants to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable copyright license
to reproduce, prepare Derivative Works of, publicly display, publicly perform, sublicense, and distribute the
Work and such Derivative Works in Source or Object form.

3 Grant of Patent License. Subject to the terms and conditions of this License, each Contributor hereby grants
to You a perpetual, worldwide, non-exclusive, no-charge, royalty-free, irrevocable (except as stated in this
section) patent license to make, have made, use, offer to sell, sell, import, and otherwise transfer the Work,
where such license applies only to those patent claims licensable by such Contributor that are necessarily
infringed by their Contribution(s) alone or by combination of their Contribution(s) with the Work to which
such Contribution(s) was submitted. If You institute patent litigation against any entity (including a cross-
claim or counterclaim in a lawsuit) alleging that the Work or a Contribution incorporated within the Work
constitutes direct or contributory patent infringement, then any patent licenses granted to You under this
License for that Work shall terminate as of the date such litigation is filed.

4 Redistribution. You may reproduce and distribute copies of the Work or Derivative Works thereof in any
medium, with or without modifications, and in Source or Object form, provided that You meet the following
conditions:

a (a) You must give any other recipients of the Work or Derivative Works a copy of this License; and
b (b) You must cause any modified files to carry prominent notices stating that You changed the files; and

€ (c) You must retain, in the Source form of any Derivative Works that You distribute, all copyright, patent,
trademark, and attribution notices from the Source form of the Work, excluding those notices that do
not pertain to any part of the Derivative Works; and

d (d) Ifthe Work includes a "NOTICE" text file as part of its distribution, then any Derivative Works that You
distribute must include a readable copy of the attribution notices contained within such NOTICE file,
excluding those notices that do not pertain to any part of the Derivative Works, in at least one of the
following places: within a NOTICE text file distributed as part of the Derivative Works; within the Source
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form or documentation, if provided along with the Derivative Works; or, within a display generated by
the Derivative Works, if and wherever such third-party notices normally appear. The contents of the
NOTICE file are for informational purposes only and do not modify the License. You may add Your own
attribution notices within Derivative Works that You distribute, alongside or as an addendum to the
NOTICE text from the Work, provided that such additional attribution notices cannot be construed as
modifying the License.

You may add Your own copyright statement to Your modifications and may provide additional or different
license terms and conditions for use, reproduction, or distribution of Your modifications, or for any such
Derivative Works as a whole, provided Your use, reproduction, and distribution of the Work otherwise
complies with the conditions stated in this License.

5 Submission of Contributions. Unless You explicitly state otherwise, any Contribution intentionally submitted
for inclusion in the Work by You to the Licensor shall be under the terms and conditions of this License,
without any additional terms or conditions. Notwithstanding the above, nothing herein shall supersede or
modify the terms of any separate license agreement you may have executed with Licensor regarding such
Contributions.

6 Trademarks. This License does not grant permission to use the trade names, trademarks, service marks, or
product names of the Licensor, except as required for reasonable and customary use in describing the origin
of the Work and reproducing the content of the NOTICE file.

7 Disclaimer of Warranty. Unless required by applicable law or agreed to in writing, Licensor provides the
Work (and each Contributor provides its Contributions) on an "AS IS" BASIS, WITHOUT WARRANTIES OR
CONDITIONS OF ANY KIND, either express or implied, including, without limitation, any warranties or
conditions of TITLE, NON-INFRINGEMENT, MERCHANTABILITY, or FITNESS FOR A PARTICULAR
PURPOSE. You are solely responsible for determining the appropriateness of using or redistributing the
Work and assume any risks associated with Your exercise of permissions under this License.

8 Limitation of Liability. In no event and under no legal theory, whether in tort (including negligence), contract,
or otherwise, unless required by applicable law (such as deliberate and grossly negligent acts) or agreed
to in writing, shall any Contributor be liable to You for damages, including any direct, indirect, special,
incidental, or consequential damages of any character arising as a result of this License or out of the use
or inability to use the Work (including but not limited to damages for loss of goodwill, work stoppage,
computer failure or malfunction, or any and all other commercial damages or losses), even if such Contributor
has been advised of the possibility of such damages.

9 Accepting Warranty or Additional Liability. While redistributing the Work or Derivative Works thereof, You
may choose to offer, and charge a fee for, acceptance of support, warranty, indemnity, or other liability
obligations and/or rights consistent with this License. However, in accepting such obligations, You may act
only on Your own behalf and on Your sole responsibility, not on behalf of any other Contributor, and only if
You agree to indemnify, defend, and hold each Contributor harmless for any liability incurred by, or claims
asserted against, such Contributor by reason of your accepting any such warranty or additional liability.

END OF TERMS AND CONDITIONS

APPENDIX: How to apply the Apache License to your work.

To apply the Apache License to your work, attach the following boilerplate notice, with the fields enclosed by
brackets "[]" replaced with your own identifying information. (Don't include the brackets!) The text should be
enclosed in the appropriate comment syntax for the file format. We also recommend that a file or class name
and description of purpose be included on the same "printed page" as the copyright notice for easier
identification within third-party archives.

Copyright [yyyy] [name of copyright owner]

Licensed under the Apache License, Version 2.0 (the "License"); you may not use this file except in compliance
with the License. You may obtain a copy of the License at
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http://www.apache.org/licenses/LICENSE-2.0

Unless required by applicable law or agreed to in writing, software distributed under the License is distributed
on an "AS IS" BASIS, WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied. See
the License for the specific language governing permissions and limitations under the License.


http://www.apache.org/licenses/LICENSE-2.0
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